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Раздел 1: Краткая инструкция по установке

Установка под Windows 

(Только для ОС семейства Windows)

Подготовка Mbox 2 к работе с компьютером с ОС Windows включает следующие шаги:

1) “Подключение Mbox 2 и установка Pro Tools LE”, стр 9.

2) “Запуск Pro Tools LE”, стр. 11.

Ваш код авторизации находится на внутренней стороне передней обложки англоязычного руководства.

3)Настройка системы для улучшения производительности (См. Раздел 5, “Настройка Вашей системы Pro Tools”).

4) Коммутация аудио в Mbox 2 . (См. “Подключение к студийному оборудованию”, стр. 35)

Установка под Mac 

(Только для систем Mac OS X)

Подготовка Mbox 2 к работе с компьютером Mac включает следующие шаги:

I
1) “Подключение Mbox 2 к компьютеру ”, стр. 14

2) “Установка Pro Tools LE”, стр. 13.

3) “Запуск Pro Tools LE”, стр. 14.

Ваш код авторизации находится на внутренней стороне передней обложки англоязычного руководства.

4) Настройка системы для улучшения производительности (См. “Настройка Вашей системы Pro Tools”, стр. 19).

5) Коммутация аудио в Mbox 2. (См. “Подключение к студийному оборудованию”, стр. 35)

Раздел 2: Знакомство с Mbox 2 Pro

Знакомьтесь с портативной цифровой студией Mbox ® 2 от Digidesign®

Mbox 2 Pro обеспечивает компьютер с шиной Firewire четырьмя входными каналами аналогового аудио, шестью выходными каналами аналогового аудио, двумя цифровыми каналами входа/выхода, портами MIDI In и Out, двумя аналоговыми мониторными выходами, и двумя выходами на наушники с регулировкой громкости на передней панели. Mbox 2 Pro имеет микрофонные предусилители профессионального уровня и 24-битные АЦП/ЦАП

Комплектация Mbox 2 Pro

В комплект Mbox 2 Pro входит:

• Настольный аудио интерфейс Mbox 2 Pro с внешним питанием

• Установочный диск Pro Tools, содержащий 

ПО Pro Tools LE™, плагины DigiRack RTAS (Real-

Time AudioSuite) и AudioSuite, дополнительное ПО и электронную документацию в формате PDF 

• Краткую инструкцию по работе с Mbox 2 Pro

• Кабель Firewire (6-pin 1394)

• Адаптер питания 

• Регистрационную карту Digidesign 

Характеристики Mbox 2 Pro

Mbox 2 Pro предлагает следующее:

Аудио входы и выходы:

Аналоговые входы

• Два аналоговых входных канала с микрофонными предусилителями и отключаемым 48В фантомным питанием. Аналоговые входы каждого канала включают в себя универсальный разъем XLR/TRS на передней панели и 1/4" (6.35мм) джека DI, также на передней панели находится переключатель источника «Mic/DI» с индиктатором. На каждом входном канале имеется независимый –20дБ аттенюатор.

• Два дополнительных канала аналогового входа поддерживают линейные и Phono (RIAA) источники. 

Аналоговые выходы:

• Два 1/4" (6.35мм) TRS аналоговых выхода на мониторы

• Четыре дополнительных 1/4" (6.35мм) балансных аналоговых линейных выхода 
• Два дополнительных канала небалансного выхода на одном 1/4" (6.35мм) джеке TRS 
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Цифровой вход/выход

• Два цифровых канала входа/выхода S/PDIF. Входы S/PDIF работают независимо и в дополнение к аналоговым входам 1–4, при синхронизации по S/PDIF. Выходы S/PDIF всегда доступны в Pro Tools.

MIDI

• Один порт MIDI In и один порт MIDI обеспечивают 16 входных и 16 выходных каналов MIDI.

Другие возможности и спецификации

• 24-битные АЦП/ЦАП, поддерживающие частоту дискретизации 44.1 кГц, 48 кГц, 88.2 кГц и 96 кГц.

• Аналоговый мониторинг записи с низкой задержкой.

• Два 1/4" (6.35 мм) TRS стерео выхода на наушники (A и B) с регулировкой громкости. Наушники B могут дублировать выход А (выходные каналы 1-2) или быть переключены на выходные каналы 3-4.

Возможности Pro Tools LE 

Pro Tools LE на платформах Windows и Mac при использовании совместно Mbox 2 Pro предоставляет следующие возможности:

• Воспроизведение до 32 моно (или 16 стерео) цифровых аудио треков или запись и воспроизведение цифровых аудиотреков общим количеством до 32 моно (или 16 стерео) в зависимости от производительности вашего компьютера. 

• Емкость сессии: до 128 аудиотреков (максимум 32 трека одновременного воспроизведения), 128 треков Aux, 64 трека мастер фейдера, 256 треков MIDI и 32 инструментальных трека

• 16-битный или 24-битный формат аудио с частотой дискретизации до 48 кГц

• Неразрушительное редактирование с произвольным доступом и автоматизация микса

• Обработка аудио с использованием до 5 плагинов RTAS на трек, в зависимости от производительности вашего компьютераs

• До 5 инсертов на трек

• До 10 посылов на трек

• До 32 внутренних шин микширования

Pro Tools LE использует центральрный процессор вашего компьютера для микширования и обоработки аудио треков. Компьютеры с большей тактовой частотой позволяют работать с большим количеством треков и плагинов
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Требования к системе 

Mbox 2 Pro должен использоваться с соответствующим требованиям Digidesign компьютером на платформе Windows или Mac с установленным ПО Pro Tools LE 

Для установки Pro Tools с установочного диска требуется привод DVD.

Полный список требований к системе приведен на сайте Digidesign (www.digidesign.com).

Информация о совместимости

Digidesign может гарантировать совместимость и обеспечить поддержку только тех аппаратных и программных конфигураций, которые были протестированы и сертифицированы.

Актуальный список сертифицированных Digidesign компьютеров, ОС, жестких дисков и устройств третьих производителей приведен на сайте Digidesign (www.digidesign.com).

Требования MIDI

Mbox 2 Pro имеет один порт MIDI In и один порт MIDI, обеспечивающие 16 входных и 16 выходных каналов MIDI. Если вам требуются дополнительные порты MIDI, добавьте в свою систему MIDI интерфейс. 

MIDI интерфейсы с подключением по USB эффективно работают с системами Pro Tools на платформах Windows и Mac. MIDI интерфейсы с подключением к последовательному порту поддерживаются только для платформы Windows

Список поддерживаемых устройств приведен на сайте Digidesign (www.digidesign.com).

Только MIDI интерфейсы с подключением по USB совместимы с системами Pro Tools на платформе Mac OS X. Адаптеры с последовательного на параллельный порт и MIDI устройства с подключением через последовательный порт не поддерживаются.

Список поддерживаемых адаптеров содержится на сайте Digidesign (www.digidesign.com).

Требования к жесткому диску

Для оптимального воспроизведения и записи звука всем системам Pro Tools требуется один или более жесткий диск, сертифицированный Digidesign. Список сертифицированных Digidesign жестких дисков приведен на сайте Digidesign (www.digidesign.com).

Если вы используете жесткий диск с шиной ATA/IDE или FireWire, инициализируйте ваш диск при помощи утилит Windows Disk Management (Windows) или Disk Utility (Mac).

За дополнительной информацией обращайтесь к Приложению С “Конфигурация и эксплуатация жесткого диска”.

Избегайте записи на системный диск.

Запись на системный диск не рекомендуется.

Запись и воспроизведение с системного диска может привести к уменьшению количества доступных к использованию треков и плагинов.

Digidesign не рекомендует вести запись на системный диск. Записывайте на системный диск только в случае необходимости.

Регистрация Digidesign

Прочитайте информацию на прилагаемой карточке регистрации Digidesign и следуйте изложенным в ней инструкциям, чтобы оперативно зарегистрировать свою покупку через интеренет. Регистрация покупки – единственный способ получить право на сопутствующую техническую поддержку и предложения апгрейда системы. Это один из наиболее важных первых шагов пользователя. Регистрация своей покупки – это единственный способ получить право на:
· Дополнительную техническую поддержку

· Апдейт до самой последней на момент покупки версии Pro Tools, если вы купили продукт с более старой версией в коробке

· Специальные предложения по обновлению системы в будущем

[Стр. 6]
.

Документация Pro Tools

Это руководство пользователя объясняет, как установить ПО Pro Tools LE, произвести коммутацию вашего интерфейса Mbox 2 Pro (подавать на него звук и получать от него звук) и выполнять основные задачи (например, запись Pro Tools).

Помимо всех печатных руководств и документации, входящих в комплект вашей системы, вместе с Pro Tools автоматически устанавливаются руководства Pro Tools в формате PDF и файлы «Read Me».

Ключевые руководства (такие как «Pro Tools Reference Guide» и «Pro Tools Menus Guide») доступны через меню «Help» Pro Tools

• «Pro Tools Reference Guide» детально объясняет ПО Pro Tools

• «Pro Tools Menus Guide» описывает все экранные меню Pro Tools

• «DigiRack Plug-Ins Guide» объясняет как использовать плагины RTAS и AudioSuite plug-ins, входящие в пакет Pro Tools.

• «Digidesign Plug-Ins Guide» объясняет, как использовать дополнительные плагины «Digidesign»

• «Pro Tools Shortcuts» содержит список «горячих клавиш» и функций правой кнопки мыши в Pro Tools.

Эти и другие руководства помещаются во время инсталляции на исходный жесткий диск. Чтобы просмотреть или распечатать руководства в формате PDF, вы можете использовать Adobe Reader

или Apple Preview (только Mac).

Печатные копии «Pro Tools Reference Guide» и других руководств Pro Tools могут быть заказаны отдельно через Интернет-магазин DigiStore (www.digidesign.com).
Система обозначений в руководстве
Руководства Digidesign используют следующую систему обозначения для пунктов меню и ключевых команд

	Обозначение
	Действие

	File > Save
	Выберите пункт « Save» в меню «File»

	Control+N
	Удерживая клавишу «Control» нажмите клавишу «N»

	Control-click
	Удерживая клавишу «Control» нажмите кнопку мыши

	Right-click
	Нажмите правую кнопку мыши


Следующие символы используются для обозначения важной информации:

Подсказка: полезные указания о том, как наиболее эффективно использовать вашу систему Pro Tools.

Важное замечание: содержит информацию, от которой зависит ваш материал или производительность системы

Горячая команда: Быстрый доступ к командам через клавиатуру или мышь.

Ссылка: Указывает на соответствующие теме разделы этого и других руководств Digidesign.
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О www.digidesign.com

Сайт Digidesign (www.digidesign.com) – это лучший для вас источник информации, которая поможет вам добиться наибольших результатов от любых систем Pro Tools. Ниже приводятся только некоторые из доступных сервисов и возможностей.

Регистрация. Зарегистрируйте свою покупку через Интернет. Инструкции приводятся в прилагаемой регистрационной карточке Digidesign.

Поддержка. Обращайтесь в службу технической поддержки Digidesign или службу работы с клиентами; скачивайте обновления ПО и последние электронные версии руководств; изучайте документацию по совместимости и требования к системе; просматривайте он-лайн базу знаний; присоединяйтесь к мировому сообществу пользователей Pro Tools через конференцию пользователей Digidesign

Обучение и образование. Станьте сертифицированным Оператором или Экспертом Pro Tools; пройдите индивидуальные Интернет-курсы или узнайте как можно пройти очное обучение в сретифицированном центре обучения Pro Tools.

Продукты и разработчики. Узнайте о продуктах Digidesign; загружайте демо-версии ПО; узнайте о наших партнерах по разработке их плагинах, приложениях и оборудовании.

Новости и события. Узнайте последние новости Digidesign; подпишитесь на демо-программу Pro Tools.

Чтобы узнать больше об этих и других ресурсах, посетите сайт Digidesign (www.digidesign.com).
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Раздел 3 Конфигурация Windows

Этот раздел содержит информацию только для систем Windows. Если вы устанавливаете Pro Tools на платформе Mac, обратитесь к Разделу 4 “Конфигурация Mac”.

Перед установкой этой версии Pro Tools ознакомьтесь с информацией в файле Read Me на установочном диске Pro Tools. 

Ход установки

Установка Mbox 2 Pro на платформе Windows включает в себя следующие шаги

1 “Подключение Mbox 2 Pro и установка Pro Tools LE”, стр 9.

2 “Запуск Pro Tools LE”, стр. 11.

3 Настройка системы для улучшения производительности (См. Раздел 5 “Настройка Вашей системы Pro Tools”).

4  Коммутация аудио и MIDI в Mbox 2 Pro. (См. Раздел 7 “Подключение к студийному оборудованию”)

Подключение Mbox 2 Pro и установка Pro Tools LE

Чтобы установить Pro Tools LE и Mbox 2 Pro:

1 Запустите Windows, войдя с полномочиями Администратора. Подробно о полномочиях Администратора написано в документации Windows.

2 Подключите один конец прилагаемого кабеля Firewire к порту Firewire на Mbox 2 Pro.

3 Подключите другой конец кабеля к любому свободному порту Firewire (6-pin 1394) на вашем компьютере. Дождитесь появления диалога «Найдено новое оборудование» и оставьте его открытым: не нажимайте «Далее». Если мастер начинает автоматически устанавливать драйверы, нажмите «Отмена».

В процессе установки вы должны игнорировать все диалоги “Найдено новое оборудование”, не нажимайте «Далее»
4 Вставьте установочный диск Pro Tools LE для Windows в привод  DVD

5 Найдите и откройте на установочном диске папку Pro Tools Installer.
6 Двойным щелчком выберите иконку «Setup».

7 Следуйте инструкциям, отображаемым на экране в процессе установки
8 Выберите место установки. Для максимальной надежности, установите Pro Tools на своем загрузочном диске.
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9 Нажмите кнопку «Next».

10 Выберите приложение Pro Tools для установки.

11 Вы также можете выбрать дополнительные утилиты из списка для установки вместе с Pro Tools.

Поддержка дисков Mac HFS+. Эта опция дает возможность вашей системе Pro Tools осуществлять чтение, воспроизведение и запись с дисками формата Mac HFS+. Диски HFS+ обычно называют расширенными дисками Mac OS.

DigiTranslator DigiTranslator™ - программная опция для Pro Tools, которая дает вам возможность осуществлять конвертацию и обмен данными секвенций OMF и AAF и файлов MXF непосредственно в Pro Tools. Эта опция покупается отдельно.

Драйвер контроллера Command|8. Драйвер Command|8 необходим, если вы используете аппаратный контроллер Digidesign Command|8.

Экспорт MP3. Опция экспорта MP3 дает вам возможность экспортировать файлы MP3 из сессий Pro Tools. Эта опция покупается отдельно.

Установочный диск Pro Tools Installer содержит дополнительное программное обеспечение для вашей системы. Информация об этом содержится в параграфе «Дополнительное ПО на установочном диске Pro Tools» на стр. 11.
12 Нажмите «Next».

13 Нажмите «Install».

ОС Windows XP может выдавать в процессе установки несколько сообщений, которые можно проигнорировать, в частности, несколько диалогов “Найдено новое оборудование” и “Обнаружена проблема во время установки оборудования»

Если появится предупреждение о том, что драйвер не сертифицирован для Windows, нажмите 

«Все равно продолжать».

На Windows Vista, eсли появится предупреждение о драйвере, нажмите  «Все равно установить этот драйвер».

14 Перед тем, как перейти к следующему шагу, дождитесь, пока программа установки закончит установку всех программных компонентов, драйверов и системных файлов PACE.

15 По завершении установки нажмите «Finish».

Установка QuickTime

QuickTime требуется Pro Tools, если вы планируете включать в сессию видео файлы, или импортировать файлы MP3 или MP4 (AAC). QuickTime для Windows XP можно бесплатно загрузить с сайта Apple (www.apple.com).

Информация о том, какая версия QuickTime совместима с вашей версией Pro Tools содержится в списке совместимости на сайте Digidesign (www.digidesign.com).

Чтобы установить QuickTime:

1 Зайдите на сайт www.apple.com и перейдите на страницу QuickTime 

2 Загрузите на свой компьютер программу установки QuickTime.

3 Двойным щелчком запустите установщик QuickTime и следуйте появляющимся на экране инструкциям установки.
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4 Перезагрузите компьютер.

Отключение экранной заставки

(Только Windows Vista)

Чтобы избежать ошибок во время записи и воспроизведения сессий Pro Tools, вы должны установить заставку экрана  Windows Vista в режим «Нет»

Чтобы установить заставку экрана Windows Vista в режим «Нет»:

1 Щелкните правой кнопкой мыши на рабочем столе.

2 Выберите «Настройки».

3 Выберите «Заставка экрана»

4 Установите заставку в режим «Нет»
5 Нажмите «Применить»
Запуск Pro Tools LE

При первом запуске Pro Tools LE от вас потребуется ввести код авторизации.

Чтобы авторизировать свою копию Pro Tools LE:

1 Убедитесь, что Mbox 2 Pro подключен к вашему компьютеру и на него подается питание.

2 Дважды щелкните на иконке Pro Tools LE на своем рабочем столе (или на иконке приложения в папке Pro Tools, вложенной в папку Digidesign.

3 Введите код авторизации в диалоговом окне (убедитесь, что набираете его точно так же, как он напечатан, проверяя пробелы и использование заглавных букв), затем нажмите кнопку «Validate».

Ваш код авторизации находится на внутренней стороне обложки англоязычного руководства.

Дополнительное ПО на установочном диске Pro Tools

Установочный диск Pro Tools содержит дополнительное ПО для вашей системы, включая аудио драйверы (для обеспечения работы других аудио приложений с вашим оборудованием Digidesign) и демонстрационную сессию Pro Tools.

Дополнительное ПО и программы установки содержатся на установочном диске Pro Tools
Аудио драйверы Windows

Драйверы Mbox 2 Pro ASIO Driver и DirectSound Windows System Audio Driver позволяют использовать ваш аппаратный интерфейс Digidesign Mbox 2 Pro с приложениями сторонних разработчиков, которые поддерживают драйверы стандартов ASIO или DirectSoundю
Драйверы Mbox 2 Pro ASIO Driver и DirectSound Driver для Mbox 2 Pro автоматически устанавливаются вместе с Pro Tools.

Mbox 2 Pro ASIO Driver

Драйвер Mbox 2 Pro ASIO (Audio Sound Input Output) Driver – многоканальный драйвер с поддержкой одного клиента, который позволяет программам сторонних разработчиков, поддерживающих стандарт ASIO осуществлять запись и воспроизведение через Mbox 2 Pro
Подробная информация о настройке драйвера Mbox 2 Pro ASIO Driver содержится в руководстве «Windows Audio Drivers Guide».
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DirectSound Windows System Audio Driver 
Драйвер DirectSound Windows System Audio Driver – многоканальный драйвер с поддержкой нескольких клиентрв, который позволяет программам сторонних разработчиков, поддерживающих стандарт DirectSoundосуществлять запись и воспроизведение через Mbox 2 Pro
Подробная информация о настройке драйвера DirectSound Windows System Audio Driver содержится в руководстве «Windows Audio Drivers Guide».

Отдельные драйверы Digidesign Windows Audio

Драйверы Digidesign Windows Audio могут быть установлены и на системы, на которых не установлено ПО Pro Tools. В этом случае используйте версию для независимой установки драйверов Digidesign Windows Audio Drivers (Digidesign Audio Drivers Setup.exe), находящуюся на установочном диске Pro Tools.

Информация о настройке независимо устанавливаемых драйверов Digidesign Windows Audio содержится в руководстве «Windows Audio Drivers Guide».

Демонстрационная сессия Pro Tools

Установочный диск Pro Tools LE содержит демонстрационную сессию, которую можно использовать для проверки работоспособности системы.

Демо-сессия для Pro Tools LE называется “Filtered Dreams”.

Перед тем как установить демо-сессию на свой диск для аудио, убедитесь, что диск настроен так, как описано в параграфе «Форматирование аудио диска», стр. 64.
Чтобы установить демо-сессию:

1 Вставьте установочный диск Pro Tools LE в привод DVD.

2 Найдите и откройте на диске DVD папку Additional Files/Pro Tools LE Demo Session Installer.

3 Двойным щелчком запустите Setup.exe.

4 Следуйте инструкциям на экране
5 Выберите в качестве места установки свой диск для аудио и нажмите «Install».

6 По завершении инсталляции нажмите «OK».

Демо-сессия может быть открыта двойным щелчком на файле Filtered Dream.ptf (расположенном в папке Filtered Dream Demo Session).

Удаление Pro Tools

Если вам требуется удалить ПО Pro Tools со своего компьютера, вы можете использовать команды Windows для удаления программ.

Чтобы удалить Pro Tools со своего компьютера (Windows Vista):

1 Войдите в меню Пуск > Панель управления.

2 В пункте Программы нажмите “Удаление программы”

3 Выберите Pro Tools.

4 Нажмите «Удалить».

5 Чтобы удалить Pro Tools следуйте инструкциям на экране.

Чтобы удалить Pro Tools со своего компьютера (Windows XP):

1 Войдите в меню Пуск > Настройка > Панель управления.

2 Двойным щелчком выберите “Установка и удаление программ”.

3 В списке «Установленные программы» выберите Digidesign Pro Tools.

4 Нажмите кнопку «Удалить»

5 Чтобы удалить Pro Tools следуйте инструкциям на экране.
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Раздел 4 Конфигурация Mac 

Этот раздел содержит информацию только для систем Mac. Если вы устанавливаете Pro Tools на платформе Windows, обратитесь к Разделу 3 “Конфигурация Windows”.

Перед установкой этой версии Pro Tools ознакомьтесь с информацией в файле Read Me на установочном диске Pro Tools. 

Ход установки

Установка Mbox 2 Pro  на платформе Mac включает в себя следующие шаги:

1 “Установка Pro Tools LE ”, стр. 15.

2 “Подключение Mbox 2 Pro  к компьютеру ”, стр 16.

3 “Запуск Pro Tools LE”, стр 17.

4  Настройка системы для улучшения производительности (См. Раздел 5 “Настройка вашей системы Pro Tools”,).

5 Коммутация аудио в Mbox 2 Pro . (см. Раздел 7, “Подключение оборудования»)

Установка Pro Tools LE

После того, как программные настройки ОС Apple проведены, можно приступить к инсталляции Pro Tools LE.

Чтобы установить Pro Tools LE для Mac OS X:

1 Убедитесь, что учетная запись, под которой вы устанавливаете Pro Tools, имеет полномочия Администратор. Подробно о полномочиях Администратора написано в документации Apple Mac OS 

2 Вставьте установочный диск Pro Tools LE для Windows в привод CD/DVD

3 Найдите на установочном диске и запустите двойным щелчком “Install Pro Tools.”

4 Следуйте инструкциям, отображаемым на экране в процессе установки.

5 Выберите место установки. Для максимальной надежности, установите Pro Tools на своем загрузочном диске.

6 Нажмите «Continue».

7 Выберите приложение Pro Tools для установки.
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8 Вы также можете выбрать дополнительные утилиты из списка для установки вместе с Pro Tools:

DigiTranslator DigiTranslator™ - программная опция для Pro Tools, которая дает вам возможность осуществлять конвертацию и обмен данными секвенций OMF и AAF и файлов MXF непосредственно в Pro Tools. Эта опция покупается отдельно.

MIDI I/O Driver Драйвер MIDI I/O Driver требуется, если вы используете интерфейс Digidesign MIDI I/O.

Экспорт MP3. Опция экспорта MP3 дает вам возможность экспортировать файлы MP3 из сессий Pro Tools. Эта опция покупается отдельно.

Установочный диск Pro Tools Installer содержит дополнительное программное обеспечение для вашей системы. Информация об этом содержится в параграфе «Дополнительное ПО на установочном диске Pro Tools» на стр. 17.
9 Нажмите «Install».
10 Если будет запрошен ваш пароль Администратора введите его, и нажмите OK, чтобы подтвердить правомочность установки.

11 Следуйте остальным инструкциям на экране.

12 По завершении инсталляции нажмите «Restart».

Подключение Mbox 2 Pro к компьютеру

Перед запуском Pro Tools LE подключите к своему компьютеру Mbox 2 Pro.

Чтобы подключить Mbox 2 Pro к вашему компьютеру:

1 Подключите один разъем прилагаемого кабеля FireWire к порту FireWire на Mbox 2 Pro.

2 При включенном компьютере подключите другой разъем кабеля FireWire к любому свободному порту FireWire на вашем компьютере.

Запуск Pro Tools LE

При первом запуске Pro Tools LE от вас потребуется ввести код авторизации, чтобы активировать свою копию ПО. 

Чтобы авторизировать свою копию Pro Tools LE:

1 Убедитесь, что Mbox 2 Pro подключен к вашему компьютеру и на него подается питание.

2 Дважды щелкните на иконке Pro Tools LE на своем рабочем столе (или на иконке приложения в папке Pro Tools, вложенной в папку Digidesign.

3 Введите код авторизации в диалоговом окне (убедитесь, что набираете его точно так же, как он напечатан, проверяя пробелы и использование заглавных букв), затем нажмите кнопку «Validate».

Ваш код авторизации находится на внутренней стороне обложки англоязычного руководства.
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Дополнительное ПО на установочном диске Pro Tools

Установочный диск Pro Tools содержит дополнительное ПО для вашей системы, включая аудио драйверы (для обеспечения работы других аудио приложений с вашим оборудованием Digidesign) и демонстрационную сессию Pro Tools.

Дополнительное ПО и программы установки содержатся на установочном диске Pro Tools.

Драйвер Mbox 2 Pro  CoreAudio

Mbox 2 Pro  CoreAudio – многоканальный, многоклиентный драйвер, который позволяет совместимым с CoreAudio приложениям осуществлять запись и воспроизведение через оборудование Digidesign.

Драйвер Mbox 2 Pro  CoreAudio автоматически устанавливается вместе с Pro Tools.

Подробная информация о настройке драйвера Mbox 2 Pro  CoreAudio содержится в руководстве «CoreAudio Drivers Guide»
Отдельный драйвер Mbox 2 Pro  CoreAudio Driver
Драйвер Mbox 2 Pro  CoreAudio может быть установлен и на системы, на которых не установлено ПО Pro Tools. В этом случае используйте версию для независимой установки, находящуюся на установочном диске Pro Tools (в папке Additional Files Folder). 

Информация об инсталляции и настройке независимо устанавливаемого Mbox 2 Pro CoreAudio драйвера содержится в руководстве «CoreAudio Drivers Guide»

Демонстрационная сессия Pro Tools

Установочный диск Pro Tools LE содержит демонстрационную сессию, которую можно использовать для проверки работоспособности системы.

Демо-сессия для Pro Tools LE называется “Filtered Dreams”.

Перед тем как установить демо-сессию на свой диск для аудио, убедитесь, что диск настроен так, как описано в параграфе «Форматирование аудио диска», стр. 64
Чтобы установить демо-сессию:

1 Вставьте установочный диск Pro Tools LE в привод DVD.

2 Найдите и откройте на диске DVD папку Additional Files/Pro Tools LE Demo Session Installer.

3 Двойным щелчком запустите Setup.exe.

4 Следуйте инструкциям на экране

5 Выберите в качестве места установки свой диск для аудио и нажмите «Next», чтобы начать инсталляцию.

6 По завершении инсталляции нажмите «OK».
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Шаблоны сессий Pro Tools 

Инсталляционный диск Pro Tools LE содержит фабричные шаблоны сессий, которые заранее настроенные на распространенные конфигурации треков и микшеров. Используя эти шаблоны, вы можете избавиться от необходимости создания конфигурации студии с нуля всякий раз, когда вы начинаете новую сессию

Информация об использовании и настройке шаблонов сессий содержится в “Pro Tools Reference Guide”.

Чтобы установить фабричные шаблоны сессий:

1 Вставьте установочный диск Pro Tools в привод DVD.

2 На диске DVD найдите и откройте папку Additional Files/LE Session Templates Installer 

3 Двойным щелчком запустите LE Session Templates Setup.exe.

4 Следуйте инструкциям на экране.

5 При запросе выберите свой диск для аудио в качестве места установки и нажмите «Next», чтобы начать установку.

6 По завершении установки нажмите «Close».

Демо-сессия может быть открыта двойным щелчком на файле Filtered Dream.ptf (расположенном в папке Filtered Dream Demo Session).

Удаление Pro Tools

Если вам нужно удалить ПО Pro Tools со своего компьютера, используйте приложение Uninstaller.

Чтобы удалить Pro Tools со своего компьютера:

1 Убедитесь, что под учетной записью, где установлена система Pro Tools, вы вошли как администратор.

Подробно о полномочиях администратора в Mac OS X см. документацию Apple OS X.

2 Откройте Applications/Digidesign/Pro Tools/Pro Tools Utilities и двойным щелчком откройте файл “Uninstall Pro Tools”.

3 Нажмите «Continue», чтобы продолжить удаление.

4 Выберите тип удаления, который вы хотите произвести:

Safe Uninstall Оставляет определенные плагины и системные файлы, необходимые для совместимости с некоторыми продуктами Avid.

Clean Uninstall Удаляет все файлы Pro Tools, включая системные файлы, плагины Digidesign и имена патчей MIDI.

5 Нажмите «Uninstall».

6 Введите свой пароль администратора и нажмите «ОК».

7 Нажмите «Finish», чтобы закрыть окно “Uninstaller».
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Раздел 5. Настройка Pro Tools LE

После подключения системы и установки ПО Pro Tools вы готовы, чтобы включить и настроить свою систему Pro Tools.

Включение и выключение вашей системы

Чтобы убедиться, что компоненты вашей системы Pro Tools корректно взаимодействуют друг с другом, вы должны включать их в определенном порядке.

Запускайте свою систему Pro Tools в следующем порядке:

1 Уберите громкость всех выходных устройств вашей системы.

2 Включите все внешние жесткие диски. Подождите примерно десять секунд, пока они раскрутятся в рабочий режим.

3 Включите все консоли управления (такие как Command|8).

4 Включите все MIDI-интерефейсы, устройства MIDI, или периферийные устройства синхронизации.

5 Включите свой компьютер.

6 Запустите Pro Tools или аудио/MIDI приложения сторонних разработчиков.

Выключайте свою систему Pro Tools в следующем порядке:

1 Выйдите из Pro Tools и любых других приложений.

Чтобы выйти из Pro Tools, выберите меню File > Exit (Windows)

или Pro Tools > Quit (Mac).
2 Уберите громкость всех выходных устройств вашей системы или отключите их.

3 Выключите компьютер.

4 Выключите все MIDI-интерефейсы, устройства MIDI, или периферийные устройства синхронизации
5 Выключите все консоли управления.

6 Выключите все внешние жесткие диски
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Настройка Pro Tools LE
Системные установки Pro Tools 

Pro Tools LE позволяет вам изменить через диалог Playback Engine производительность системы путем изменения системных настроек, которые влияют на ее ресурсы обработки, воспроизведения и записи. 
Рис. Окно диалога Playback Engine в Mbox 2 Pro  (плагин Structure установлен)

Рис. Окно диалога Playback Engine в Mbox 2 Pro  (плагин Structure не установлен)

В большинстве случаев настройки по умолчанию обеспечивают оптимальную производительность, но у вас может возникнуть желание их изменить для работы с большим количеством аудио материала и/или обработки.

Hardware Buffer Size

Настройка Hardware Buffer Size (H/W Buffer Size) задает размер буфера, используемого для работы с большинством процессов программной обработки, таких как плагины Real-Time AudioSuite (RTAS). Настройка H/W Buffer также может быть использована для регулировки задержки мониторинга.

· Меньшее значение Hardware Buffer Size уменьшает задержку мониторинга и полезно, когда вы осуществляете запись через аудио вход.

· Большее значение Hardware Buffer Size обеспечивает больший ресурс обработки аудио и эффектов и полезно, когда вы осуществляете сведение и используете большое количество плагинов RTAS.

Помимо замедления отрисовки на экране и задержки мониторинга большие значения Hardware Buffer Size могут увеличивать задержку, вызываемую плагинами RTAS и повлиять на точность автоматизации плагинов, мьютов и синхронизации треков MIDI.

Чтобы изменить параметр Hardware Buffer Size:

1 Зайдите в меню Setup > Playback Engine.

2 В выпадающем меню H/W Buffer Size выберите размер аудио буфера, заданный в сэмплах.

3 Нажмите «OK».
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RTAS Processors

Настройка RTAS Processors задает количество процессоров вашего компьютера, выделяемое для плагинов обработки RTAS (Real-Time Audio Suite). 

На компьютерах с более чем одним процессором эта настройка позволяет управлять поддержкой многопроцессорности для обработки RTAS. Чтобы эта настройка была доступно на многопроцессорных компьютерах с поддержкой технологии Hyper-Threading, необходимо отключить Hyper-Threading. За инструкциями о том, как войти в BIOS компьютера и отключить Hyper-Threading обращайтесь к документации на ваш компьютер.

В сочетании с настройкой CPU Usage Limit настройка RTAS Processors позволяет вам управлять тем, как плагины RTAS и другие задачи Pro Tools обрабатываются системой. Например:

· В сессиях с большим количеством плагинов RTAS вы можете выделить 2 или более процессора для обработки RTAS и задать высокое значение CPU Usage Limit.

· В сессиях с небольшим количеством плагинов RTAS вы можете выделить меньше процессоров под RTAS и установить низкое значение CPU Usage Limit, чтобы оставить больше вычислительных ресурсов для точности автоматизации, отрисовки экрана и видео
· В зависимости от важности видео и отрисовки экрана в целом, а также плотности автоматизации, пробуйте различные комбинации настроек RTAS Processing иd CPU Usage Limit, чтобы получить оптимальный результат. Например, чтобы улучшить отрисовку экрана в сессии среднего размера с умеренным количеством плагинов RTAS на однопроцессорной системе, попытайтесь уменьшить количество плагинов RTAS, но держите CPU Usage Limit на максимуме.
Чтобы задать параметр RTAS Processors:

1 Зайдите в меню Setup > Playback Engine.

2 В выпадающем меню RTAS Processors выберите доступное количество процессоров, которое вы хотите отвести под обработку плагинами RTAS. Количество доступных процессоров зависит от того, сколько процессоров установлено на вашем компьютере:

· Выбирайте 1 процессор, чтобы ограничить ресурс обработки RTAS только одним процессором в системе.

· Выбирайте 2 процессора, чтобы равномерно распределять нагрузку между двумя доступными процессорами.

· На системах с 4 или более процессорами выбирайте то количество процессоров для RTAS сколько нужно

3 Нажмите «OK».
CPU Usage Limit
Параметр CPU Usage Limit задает процент вычислительных ресурсов, отводимых на программную обработку в Pro Tools. В сочетании с параметром RTAS Processors, настройка CPU Usage Limit позволяет вам управлять тем, как задачи Pro Tools обрабатываются системой.

· Низкое значение CPU Usage Limit ограничивает эффект, который обработка в Pro Tools оказывает на другие ресурсоемкие задачи, такие как отрисовка экрана, и полезно, когда вы ощущаете медленный отклик системы, или запускаете параллельно с Pro Tools другие приложения.

· Высокие значения CPU Usage Limit выделяют больше вычислительных ресурсов Tools и полезны при воспроизведение объемных сессий или использования большого количество плагинов в реальном времени
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.

Максимально доступное значение CPU Usage Limit зависит от количества процессоров в вашем компьютере и количества процессоров, которое вы отвели под обработку RTAS. Этот предел может варьироваться от 85% у однопроцессорных компьютеров до 99% у многопроцессорных компьютеров.
Увеличение параметра CPU Usage Limit может замедлить отрисовку экрана на менее производительных компьютерах.
Чтобы изменить параметр CPU Usage Limit:

1 Зайдите в меню Setup > Playback Engine.

2 В выпадающем меню CPU Usage Limit выберите процент вычислительных ресурсов, который вы хотите выделить под Pro Tools.

3 Нажмите «OK».

RTAS Engine (RTAS Error Suppression)

Опция RTAS Engine включает сообщения об ошибках RTAS во время воспроизведения и записи. Это особенно полезно, когда идет работа с инструментальными плагинами

Вы должны отключать сообщения об ошибках только в том случае, если частые ошибки RTAS прерывают ваш творческий рабочий процесс. Когда сообщения об ошибках отключены, вы можете ощутить снижения качества аудио. Однако, это может быть приемлемым, чтобы избежать остановок воспроизведения и записи при работе с инструментальными плагинами. Убедитесь, что сообщения об ошибках включены, когда вам необходимо обеспечить максимально возможное качество аудио, например при финальном миксе.

Есть одна опция RTAS Engine:

Ignore Errors During Playback/Record. Когда она активирована, Pro Tools продолжает воспроизведение и запись, даже если потребности обработки RTAS в ресурсах превосходят значение параметра CPU Usage Limit. Это может вызвать щелчки и потрескивание в аудио, но не останавливает транспорт.

Чтобы отключить сообщения об ошибках RTAS:

1 Зайдите в меню Setup > Playback Engine.

2 Выберите «Ignore Errors During Playback/Record».

3 Нажмите «OK».
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DAE Playback Buffer Size

Параметр DAE Playback Buffer Size определяет количество памяти, выделяемое под буферы дисков.  Размер буфера отображается в миллисекундах, что означает количество аудио, помещаемое в буфер, когда система читает с диска

Оптимальное значение DAE Playback Buffer Size для большинства дисковых операций – 1500 мс (Level 2).

· Значения DAE Playback Buffer Size, меньшие, чем 1500 мс (Level 2), могут уменьшить время инициализации воспроизведения или записи, но могут сказаться на устойчивости воспроизведения или записи треков при большом количестве дорожек или большой плотности редактирования, или в случае систем с медленными или сильно фрагментированными дисками.

· Значения DAE Playback Buffer Size, большие, чем 1500мс (Level 2) позволяют увеличить плотность редактирования в сессии или количество треков при медленных жестких дисках. Однако, более высокие значения могут вызвать задержку начала воспроизведения и записи или увеличение слышимой задержки воспроизведения при редактирование.
Использование больших значений DAE Playback Buffer Size оставляет меньше системной памяти для других задач. Рекомендуется использовать значение по умолчанию Level 2, если только вы не сталкиваетесь с ошибкой 9073 (“Disk too slow or fragmented”).
Чтобы изменить значение DAE Playback Buffer Size:

1 Зайдите в меню Setup > Playback Engine.

2 В выпадающем меню Playback Buffer выберите размер буфера.

3 Нажмите «OK».
Если Pro Tools требуется больше системной памяти для буфера, вас попросят перезапустить компьютер.

Cache Size

Параметр Cache Size задает количество памяти, которое DAE выделяет при предварительной буферизации аудио для воспроизведения и создания Лупов при использовании Elastic Audio.

Для большинства сессий оптимальным значением Cache Size является «Normal».

· Значение Cache Size «minimum» уменьшает количество системной памяти, используемой для операций с диском и освобождает память для других системных задач. Однако производительность при использовании функций Elastic Audio может упасть.

· Значение Cache Size «Large» улучшает производительность при использовании Elastic Audio, но также уменьшает количество памяти, доступное для других системных задач, таких как обработка RTAS.
Использование больших значений Cache Size оставляет меньше системной памяти для других задач. Рекомендуется настройка по умолчанию «Normal», если только вы не сталкиваетесь с ошибками -9500 (“Cache too small”).

Чтобы изменить Cache Size:

1 Зайдите в меню Setup > Playback Engine.

2 В разворачивающемся меню Cache Size выберите размер дискового кэша.

3 Нажмите «OK».

Резервирование системной памяти

Когда вы запускаете компьютер, Pro Tools автоматически резервирует часть системной памяти под буфер DAE Playback Buffer. Эта зарезервированная память недоступна другим приложениям, даже если приложение Pro Tools не открыто.

Вы можете настроить Pro Tools, чтобы резервировалось только минимальное количество памяти, и больше системной памяти было доступно для других приложений.
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Чтобы минимзировать резервирование системной памяти:

1 Зайдите в меню Setup > Playback Engine.

2 Выберите опцию “mize System Memory Allocation”.
3 Нажмите «OK».

4 Перезапустите компьютер.

Plug-in Streaming Buffer Size 

(Только для плагина Structure)

Эта настройка появляется в диалоге Playback Engine только, когда плагин сэмплера Structure установлен в вашей системе. Параметр Plug-in Streaming Buffer Size задает количество памяти, которое DAE выделяет для потокового воспроизведения с диска плагином Structure. Эта настройка влияет на воспроизведение только, если в настройках плагина Structure активировано потоковое чтение с диска (детали см. в руководстве «Structure Plug-in Guide»).
Оптимальное значение параметра Plug-in Streaming Buffer Size для большинства сессий 250мс (Level 2).

· Значения Plug-in Streaming Buffer Size меньшие, чем 250мс (Level 2) уменьшают количество системной памяти, используемой для воспроизведения сэмплов и освобождает память для других задач. Однако, качество аудио при воспроизведении сэмплов может ухудшиться.

· Значения Plug-in Streaming Buffer Size большие, чем 250мс (Level 2) улучшают качество аудио при воспроизведении сэмплов, но также уменьшают количество памяти, доступное для других системных задач, таких как обработка RTAS.

Использование больших значений Plug-in Streaming Buffer Size оставляет меньше системной памяти для других задач. Рекомендуется значение по умолчанию 250мс (Level 2), если только вы не испытываете проблем с качеством аудио при воспроизведении сэмплов.
Чтобы изменить значение Plug-in Streaming Buffer Size:

1 Войдите в меню Setup > Playback Engine.

2 В выпадающем меню Plug-in Streaming Buffer Size выберите размер буфера.

3 Нажмите «OK».

Оптимизация Plug-in Streaming Buffer Size

(Только для плагина Structure)

Эта опция появляется в диалоге Playback Engine только, если плагин сэмплера Structure установлен в вашей системе. Эта опция полезна, когда вы воспроизводите сэмплы с того же диска, который содержит аудио текущей сессии. Когда эта опция активирована, Pro Tools автоматически оптимизирует параметр Plug-in Streaming Buffer Size, чтобы адаптировать его как под Pro Tools, так и Structure. При включенной опции выпадающее меню Plug-in Streaming Buffer

Size не доступно.

Чтобы оптимизировать в Pro Tools параметр Plug-in Streaming Buffer Size:

1 Войдите в меню Setup > Playback Engine.

2 Выберите опцию  “Optimize for Streaming Content”.

3 Нажмите «ОК».
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Аппаратные настройки Pro Tools 

Pro Tools дает вам возможность задать по умолчанию частоту дискретизации и источник синхронизации для системы, а также ряд параметров, специфических для конкретной модели аудиоинтерфейса
Default Sample Rate

Настройка Sample Rate задает частоту дискретизации аудио, по умолчанию устанавливаемую при создании новой сессии. (Эта настройку можно изменить в диалоге Hardware Setup только, когда не открыто ни одной сессии).

Изменить частоту дискретизации при создании новой сессии Pro Tools можно, выбрав другую частоту в диалоге «New Session». (см. «Pro Tools Reference Guide»)
Чтобы изменить параметр Sample Rate по умолчанию:

1 Зайдите в меню Setup > Hardware.
Диалог Hardware Setup для Mbox 2 Pro 
2 В выпадающем меню Sample Rate выберите частоту дискретизации.

3 Нажмите «OK».
Clock Source

В диалоге Hardware Setup через параметр Clock Source можно установить источник синхронизации для системы.

Internal Используйте эту настройку, если вы записываете аналоговые сигналы напрямую в аналоговые входы 1–2 Mbox 2 Pro и/или записываете цифровой сигнал во входы 3–4 Mbox 2 Pro, а цифровое устройство синхронизируется по цифровому выходу Mbox 2 Pro digital.

S/PDIF Используйте эту настройку, если вы записываете через входы S/PDIF Mbox 2 Pro с внешнего цифрового устройство. Эта настройка будет синхронизировать Pro Tools с внешним устройством.

Вход S/PDIF доступен только тогда, когда значение Clock Source установлено как «S/PDIF».
Word Clock Используйте эту настройку для синхронизации Pro Tools LE с источником Word Сlock, подключенным к порту Word Clock In на Mbox 2 Pro.

Чтобы задать параметр Clock Source:

1 Войдите в меню Choose Setup > Hardware.

2 Выберите источник синхронизации в выпадающем меню Clock

Source 

3 Нажмите «OK».

Ваше цифровое входное устройство должно быть подключено, и на него должно быть подано питание, чтобы можно было синхронизировать с ним Pro Tools. Если входное устройство не имеет активного питания, оставьте значение Clock Source «Internal.
Настройка ввода/вывода I/O Setup

Через диалог I/O Setup вы можете маркировать в Pro Tools LE сигнальные тракты входов, выходов, инсертов и шины. Диалог I/O Setup дает графическое отображение входов, выходов и маршрутизации сигнала в Mbox 2 Pro .

Pro Tools LE имеет установки I/O Setup по умолчанию, с которых можно начать работу. Используйте диалог I/O Setup, только если вы хотите переименовать тракты ввода/вывода по умолчанию.
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Чтобы переименовать тракты ввода/вывода через I/O Setup:

1 Зайдите в меню Setup > I/O.

Диалог I/O Setup для Mbox 2 Pro 

2 Выберите закладку Input, Output, Insert или Bus, чтобы отобразились соответствующие соединения.

3 Чтобы переименовать тракт или суб-тракт, выберите его имя двойным щелчком, наберите новое имя, и нажмите «Enter».

4 Нажмите «OK».

См. «Pro Tools Reference Guide» (или выберите меню Help > Pro Tools Reference Guide) за дополнительной информацией о переименовании трактов ввода/вывода

Настройка MIDI

Если вы планируете использовать вместе с Pro Tools LE какие-либо устройства MIDI:

В системах Windows, настройте MIDI через MIDI

· Studio Setup. См. Приложение А «Настройка MIDI Studio Setup (только для Windows)

– или -

· В системах Mac, настройте MIDI через утилиту Apple Audio MIDI Setup (AMS) utility. См. приложение В “Настройка AMS (только для Mac OS X».

Резервное копирование конфигурации системы

После настойки своей системы и Pro Tools вам следует сохранить образ своего системного диска при помощи утилиты резервного копирования, такой как Bombich Carbon Copy Cloner. Таким образом вы можете быстро восстановить конфигурацию системы и настройки в случае возникновения каких-либо проблем.

Оптимизация системы Windows для Pro Tools

(Только Windows XP)

Чтобы оптимизировать для Pro Tools систему Mac, см. «Оптимизация систем Mac для Pro Tools», стр. 27.

Перед тем, как настраивать свой компьютер, убедитесь, что учетная запись, под которой вы производите установку Pro Tools имеет права Администратора. Подробно о правах Администратора рассказывается в документации Windows.

Необходимая оптимизация

Чтобы добиться оптимальной производительности от Pro Tools LE, произведите следующие настройки перед установкой аппаратной и программной составляющих системы Pro Tools.

После изменения параметров системы Windows перезагрузите компьютер

Активация DMA

Актививровав на своем компьютере DMA (Direct Memory

Access), вы освобождаете ресурсы процессора для выполнения задач Pro Tools.

В большинстве случаев параметры DMA уже корректно установлены, поскольку Windows XP определяет и активирует режим DMA по умолчанию

. 
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Чтобы активировать DMA для любого жесткого диска:

1 Выберите Пуск > Настройка > Панель управления.

2 В окне настроек двойным щелчком выберите «Система».

3 Выберите закладку «Оборудование»

4 В разделе «Диспетчер Устройств» нажмите кнопку «Диспетчер Устройств»

5 В окне «Диспетчер Устройств» выберите двойным щелчком «IDE ATA/ATAPI контроллеры», затем двойным щелчком выберитк  controllers, then double-click

the «Первичный канал IDE» своего диска

6 Выберите закладку «Дополнительные параметры».

7 Для каждого устройства установите Режим Передачи «DMA, если доступно» и нажмите кнопку «OK».

8 Повторите шаги 5–7 для всех дополнительных каналов IDE.

9 Закройте окно настройки системы.

Отключение ждущего режима и управления электропитанием

При использовании Pro Tools схема питания ждущего режима Windows должна быть установлена в режим «Включен постоянно» это помогает предотвратить остановку долговременного проигрывания или записи из-за отключений питания в системе.

Чтобы настроить электропитание Windows:

1 Выберите Пуск > Настройка > Панель управления.

2 В окне настроек двойным щелчком выберите «Электропитание».

3 Выберите закладку «Схемы управления питанием».

4 В разворачивающемся меню «Схемы управления питанием» выберите «Включен постоянно».

5 Нажмите кнопку «OK».

Это установит функции режима ожидания, спящего режима и отключения жестких дисков в состояние «Никогда».

В случае процессоров AMD обязательно убедитесь в том, что функция «Cool N’Quiet» отключена в BIOS (раздел «Cool & Quiet Configuration»).

При необходимости подробных инструкций по отключению этой опции энергопитания обратитесь к документации производителя.

Отключение функции сглаживания экранных шрифтов

При работе с Pro Tools эффект сглаживания экранных шрифтов должен быть отключен.

Чтобы отключить эффект сглаживания экранных шрифтов:

1 Выберите Пуск > Настройка > Панель управления.

2 В окне настроек двойным щелчком выберите «Экран»

3 Выберите закладку «Оформление».

4 Нажмите кнопку «Эффекты».

5 Снимите галочку «Применять следующий метод сглаживания экранных шрифтов»

6 Нажмите кнопку «OK», чтобы сохранить настройки, и закройте диалог «Эффекты».

7 Нажмите «OK».

8 Перезагрузите компьютер.
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Рекомендумая оптимизация

На работу Pro Tools может влиять другое ПО и драйверы оборудования, установленные на вашем компьютере.

Рекомендуется (но не требуется) поступать следующим образом:

• Избегать работы программ, не являющихся необходимыми, одновременно с Pro Tools.

• Отключать любые, работающие в фоновом режиме программные утилиты, такие как Windows Messenger, программы календарных оповещений и обслуживания дисков.

• Отключать любые не нужные принципиально устройства USB на время работы с Pro Tools.

• Если ваша видео карта поддерживает режим Bus Mastering, установите его в панели управления устройства. Подробности содержатся в документации производителя.

Дополнительная оптимизация

Следующие варианты оптимизации системы могут помочь повысить эффективность работы Pro Tools на некоторых компьютерах. Рекомендуется пробовать такие способы оптимизации только в случае необходимости, поскольку они могут прервать или ухудшить работу других программ в вашей системе.

Отключение сетевых плат

Если возможно, отключите все сетевые платы (кроме карт FireWire, которые используются для подключения к системе внешних дисков).

Чтобы отключить сетевую плату:

1 Правым щелчком по иконке Мой Компьютер откройте меню и выберите пункт «Управление».

2 В разделе «Служебные программы» выберите «Диспетчер Устройств».

3 В окне «Диспетчер Устройств» двойным щелчком выберите раздел «Сетевые платы», затем двойным щелчком выберите сетевой адаптер, который хотите отключить.

4 В закладке «Общие» выберите в разворачивающемся меню «Применение устройства» вариант «Это устройство не используется (отключено) и нажмите кнопку «OK».

5 Закройте окно «Управление компьютером»

.

Распределение ресурсов процессора

Чтобы настроить распределение ресурсов процессора:

1 Выберите Пуск > Настройка > Панель управления.

2 В окне настроек двойным щелчком выберите «Система».

3 Выберите закладку «Дополнительно».

4 В разделе «Производительность» нажмите кнопку «Параметры».

5 В окне «Параметры быстродействия» выберите закладку «Дополнительно».

6 В разделе Распределение времени процессора выберите опцию «служб, работающих в фоновом режиме».

7 В разделе «Использование памяти» выберите опцию «системного кэша».

8 Нажмите кнопку « OK», чтобы закрыть окно «Параметры быстродействия» 

9 Нажмите кнопку « OK», чтобы закрыть окно «Свойства системы».

10 Перезагрузите компьютер, чтобы изменения вступили в силу
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Отключение автоматически запускаемых программных модулей

Чем меньше программ работает на вашем компьютере, тем больше ресурсов доступно Pro Tools. Некоторые из автоматически запускаемых приложений могут бесполезно потреблять ресурсы процессора, и должны быть отключены.

Если вы решите отключить какой-либо из пунктов автозагрузки, делайте это обдуманно:

• Определение серийных номеров съемных носителей (требуется для приложений с ключом защиты от копирования)

• Plug-n-play

• Журнал событий

• Криптографические сервисы

• Клиент DHCP, TCP/IP Net BIOS, и другие сетевые сервисы (в случае, если компьютер не имеет сетевых подключений все эти сервисы могут быть без проблем отключены)

Чтобы отключить автоматическую загрузку программ:

1 В меню «Пуск» выберите пункт «Выполнить…»

2 Наберите в строке ввода “msconfig” и нажмите кнопку «OK». Откроется утилита «Настройка системы».

3 В закладке «Общие» выберите «Выборочный запуск».

4 В закладке отключите опцию «Запуск объектов автозагрузки» и нажмите кнопку «OK».

5 Перезагрузите компьютер.
6 После перезапуска компьютер отобразит сообщение об изменении конфигурации системы. Перед тем, как выбрать вариант «Не показывать это сообщение снова», проверьте, увеличилась ли производительность Pro Tools. Если производительность не изменилась, запустите “msconfig” и верните режим автозапуска в «Обычный». Как вариант, попробуйте отключать запуск приложений автозагрузки и ненужных процессов выборочно

Оптимизация системы Mac для Pro Tools 

(Только Mac)

Чтобы оптимизировать для Pro Tools систему Windows XP, см. «Оптимизация систем Windows для Pro Tools», стр. 24.

Чтобы добиться оптимальной производительности от Pro Tools LE, произведите следующие настройки перед установкой аппаратной и программной составляющих системы Pro Tools.

Перед тем, как настраивать свой компьютер, убедитесь, что учетная запись, под которой вы производите установку Pro Tools имеет права Администратора. Подробно о правах Администратора Mac OS X рассказывается в документации Apple OS X 

Не используйте в Mac OS X функцию Automatic Software Update, поскольку она может обновить вашу систему до версии Mac OS, не сертифицированной на совместимость с Pro Tools. Подробности о сертификации версии Mac OS можно узнать с в свежей информации о совместимости на сайте Digidesign (www.digidesign.com).

Отключение Software Update

Чтобы отключить функцию Software Update:

1 Выберите System Preferences в меню Apple, затем выберите Software Update.

2 Выберите Update Software 
3 Cнимите отметку с Check for Updates
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Выключение функции Energy Saver

Чтобы выключить функцию Energy Saver:

1 Выберите System Preferences в меню Apple, затем выберите Energy Saver.

2 Выберите Sleep, после чего:

• Установите настройку «computer sleep» Never.

• Установите настройку «setting to» Never.

• Снимите отметку с опции “Put the hard disk(s) to sleep when

possible”.

Настройка производительности процессора 

(Только для компьютеров Mac G5)

Чтобы установить параметр Processor Performance:

1 Выберите System Preferences в меню Apple, затем выберите Energy Saver.

2 Выберите Options и установите значение «Processor Performance» Highest.

Отключение функции Spotlight Indexing
В Mac OS X функция Spotlight в фоновом режиме индексирует файлы и папки, влияя на производительность системы.

Рекомендуется перед работой с Pro Tools отключать индексирование Spotlight.

Отключение индексирования Spotlight приведет к тому, что функция Find в Mac OS X больше не будет работать. Вы не сможете вести поиск файлов на дисков, установленных в режим Privacy.

Чтобы отключить индексирование Spotlight:

1 Выберите System Preferences в меню Apple, затем выберите Spotlight.

2 В окне Spotlight выберите Privacy.

3 Чтобы диск не индексировался, перетащите его иконку с рабочего стола в список.

Отключение горячих клавиш Spotlight

Функция Mac OS X Spotlight использует те же самые горячие клавиши, что используются в Pro для запуска записи (Command+Пробел) и записи-врезки (Command+Option+Пробел). Если вы хотите сохранить использование этих комбинаций в Pro Tools, вы должны отключить их в Spotlight.

Чтобы отключить горячие клавиши Spotlight:

1 Выберите System Preferences в меню Apple, затем выберите Spotlight.

2 Снимите отметку с “Spotlight menu keyboard shortcut” и “Spotlight window keyboard shortcut.”

Отключение горячей клавиши панели Dashboard

Панель быстрого доступа Mac OS X Dashboard использует ту же клавишу, что используется в Pro Tools для начала записи (F12). Если вы хотите сохранить ее использование в Pro Tools, вы должны отключить ее в Dashboard.

Чтoбы отключить горячую клавишу панели Dashboard:

1 Выберите System Preferences в меню Apple, затем выберите Dashboard, затем Exposé.

2 Установите горячую клавишу Dashboard в “–”, чтобы отключить ее.

Включение функции Journaling для дисков с аудио
Если вы планируете использовать аудио диск, который использовали с предыдущей версией Pro Tools на Mac, включите функцию Journaling.

Чтобы включить функцию Journaling:

1 Запустите приложение Disk Utility, находящееся в Applications/Utilities.

2 Выберите том в левой колонке окна Disk Utility.

3 На панели инструментов нажмите Enable Journaling
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Раздел 6. Обзор аудиоинтерфейса Mbox 2 Pro

Передняя панель Mbox 2 Pro
Передняя панель Mbox 2 Pro содержит следующее:

Рис 1. Передняя панель Mbox 2 Pro

Индикатор питания
Уровень наушников (А, B)

Уровень мониторов
AUX In (3-4)

Индикатор пиков

Чувствительность

Переключатель и индикатор источника

Input 1

Индикатор пиков

Чувствительность
Аттенюатор

Переключатель источника

Input 2

Индикатор пиков

Чувствительность

Аттенюатор

Переключатель источника

Индикаторы Di/Mic 2

Вход DI Input 2

Индикаторы Di/Mic 1

Вход DI Input 1

Выключатель и индикатор 48V

Переключатель и индикатор 3-4 (Наушники В)

Выходы на наушники (А и В)

Индикатор MIDI

Индикатор Ext Clk

Индикатор питания

Индикатор питания показывает, что Mbox 2 Pro включен.

Индикатор Ext Clk (External Clock)
Индикатор Ext Clk светится, когда текущим источником синхронизации Pro Tools является S/PDIF или Word Сlock. Когда индикатор не светится, это означает, что источник установлен как Internal.
Индикатор MIDI

Этот индикатор светится, когда Mbox 2 Pro передает или получает MIDI
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Выходы на наушники
Mbox 2 Pro имеет два 1/4" (6.35мм) стереовыхода на наушники, А и В, каждый с собственной регулировкой громкости. По умолчанию наушники дублируют мониторные выходы (в Pro Tools обычно основные выходы Analog 1–2). Наушники B также могут быть назначены на раздельный мониторинг выходов Pro Tools 3–4 (Analog 3–4) при помощи переключателя «3–4».

Громкость наушников
Ручки громкости наушников задают выходной уровень на соответствующих выходах на наушниках (A или B).

Переключатель и индикатор «3–4»
Переключатель «3–4» назначает выход на наушники B либо на основные выходы (1–2) либо на выходные каналы 3–4. Когда переключатель находится в отжатом положении, выход В дублирует выход А, а индикатор «3–4» не светится. Когда переключатель находится в нажатом положении, выход на наушники В осуществляет мониторинг выходных каналов 3-4 в Pro Tools.

Уровень мониторов
Ручка Monitor регулирует уровень сигнала на мониторных выходах Mon Out. В Pro Tools это будет сигнал, маршрутизируемый на выходы Analog 1–2.

Выключатель и индикатор фантомного питания «48V»

Фантомное питание включается переключателем на передней панели «48V». Когда горит индикатор, это значит, что 48В фантомное питание подается на оба входа Mic/Line. Эти входы обеспечивают фантомным питанием микрофоны, которым оно нужно для работы.

О фантомном питании

Динамическим микрофонам (таким, как Shure SM57) для работы не требуется фантомное питание, но оно не может им повредить. Большинству конденсаторных микрофонов (например, AKG C3000) требуется фантомное питание.

Хотя фантомное питание безопасно для большинства микрофонов, оно может представлять определенный риск для некоторых ленточных микрофонов. Прежде чем подключить или отключить ленточный микрофон обязательно отключайте фантомное питание и выдерживайте паузу не менее десяти секунд.

Если вы не уверены насчет необходимости фантомного питания для своего микрофона, обратитесь к его документации или к службе поддержки производителя.
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Настройка чувствительности
Ручки Gain регулируют входную чувствительность на соответствующих входах (Input 1, Input 2, или Aux In).

Входы DI

Разъемы «DI» на передней панели предназначены для подключения к входным каналам 1 и 2 электрогитар, бас-гитар и аналогичных инструментов.
Переключатели и индикаторы Mic/DI 
Эти переключатели задают на каждый канал входы типа Mic (XLR) и Line (TRS) или DI. Индикаторы «DI» и «Mic» отображают текущий тип входа.

Переключатель «Aux In» задает либо линейные либо Phono входы Aux.
Подробнее см. «Подключение аудио входов», стр. 37.

Индикаторы пиков 
Секции Input 1, 2 и Aux Input имеют индикаторы «Peak», которые сигнализируют о перегрузке, а также служат индикаторами уровня сигнала. Они светятся зеленым при уровне –60 dBFS, желтым при –6 dBFS и красным при 0 dBFS (пик).

Переключатели и индикаторы аттенюаторов 
Переключатели «Pad» включают -20дБ аттенюаторы на соответствующих входных каналах. Когда они включены, горят индикаторы «Pad».
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Задняя панель Mbox 2 Pro 

На рис 2 отображены все разъемы задней панели Mbox 2 Pro

Рис 2. Задняя панель Mbox 2 Pro

Задняя панель Mbox 2 Pro содержит следующее:

Input 1 и 2

Mic/Line 2 Mic/Line 1

Aux In (3–4)

Phono In L/R

Line In L/R
Мониторные выходы

(1-2)

Линейные выходы

(1-4)

Цифровой вход/выход

SP/DIF

Линейные выходы
(5-6)

Вход/Выход MIDI

Питание

Firewire

World Clock I/O

Клемма заземления
Питание
Через этот разъем на Mbox 2 Pro подается питание от входящего в комплект адаптера. Хотя внешнее питание не всегда необходимо, вы должны использовать внешнее питание, если ваша шина 1394 не в состоянии подать достаточную мощность, или вам нужно сохранить ресурс батарей в портативном компьютере.

Порт FireWire (1394) 

Этот стандартный разъем FireWire 1394 используется для подключения вашего компьютера к Mbox 2 Pro. В комплект Mbox 2 Pro входит один кабель 6-pin FireWire. Mbox 2 Pro может получать питание либо только по соединению 1394 с компьютером, либо от внешнего адаптера (входит в комплект вашей системы).

Кабель 4-Pin FireWire

В комплект Mbox 2 Pro входит 6-pin/6-pin кабель FireWire. Некоторые лаптопы на платформе Windows имеют порт 4-pin FireWire. Чтобы использовать Mbox 2 Pro с этими компьютерами, требуется кабель 4-pin/6-pin. Приобретайте этот кабель (модель #CS625) через авторизованных дилеров Digidesign или интернет-магазин DigiStore (www.digidesign.com).

Этот кабель также может быть приобретен в компьютерных магазинах. Максимальная поддерживаемая длина кабеля FireWire (IEEE-1394) 4.3м.
Вход/Выход MIDI 

Порты MIDI In и MIDI – стандартные 5-пиновые порты MIDI, каждый обеспечивает 16 каналов входа или выхода соответственно
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Вход/Выход Word Clock
Порты Word Clock In и Out позволяют подключать коаксиальные кабели с разъемом BNC, чтобы синхронизировать Pro Tools по входящему сигналу 1x Word clock или синхронизировать другие устройства с генерируемым Pro Tools сигналом Word clock.

Линейные выходы (1–4)

Эти выходы позволяют подавать отдельные выходы Pro Tools на внешние усилители для наушников, устройства записи, системы звукоусиления и другие подобные устройства. Линейные выходы 1–4 поддерживают балансные TRS или небалансные TS 1/4” (6.35мм) джеки.

Линейный выход (5–6)

К этому разъему подключается 1/4" (6.35мм) джек, который обеспечивает два небалансных выходных канала для подключения к внешнему аналоговому устройству (Line Out 5 = Tip;

Line Out 6 = Ring.)

Гнездо ножного переключателя
Гнездо ножного переключателя на Mbox 2 Pro позволяет вам использовать ножной переключатель для старта/остановки воспроизведения или старта/остановки записи «врезкой»l.

Поддерживается как функция QuickPunch записи «врезкой» аудио, так и «врезка» MIDI. 
Разъем ножного переключателя разработан для использования с педалями разового срабатывания с ¼" (6.35мм) разъемами TS connector. Педали постоянного замыкания/размыкания также могут быть использованы, но результат может быть непредсказуемым.

Цифровой вход/выход S/PDIF
Вход и выход S/PDIF реализован на небалансных двухпроводниковых фоно (RCA) разъемах по которым передается двухканальный 24-битный цифровой поток данных. Стандарт Sony/Philips Digital Interface Format (S/PDIF) используется во многих профессиональных и бытовых CD и DAT рекордерах. Чтобы избежать наводок используйте для передачи S/PDIF 75Ом коаксиальный кабель с длиной не превышающей 10м. 

При работе с прибором входные каналы S/PDIF доступны помимо четырех каналов аналогового аудио входа. Это позволяет использовать Mbox 2 с Pro Tools LE как цифровой аудио интерфейс с 6 входами и 8 выходами.

Выходные каналы S/PDIF всегда доступны в любых режимах синхронизации.

Выход на мониторы «Mon Out»

К этим выходам можно подключать 1/4" (6.35мм) стерео TRS (Tip-Ring-Sleeve) или моно TS (Tip-Sleeve) джеки. Для мониторинга вашего микса, эти выходы можно подключить к микшерному пульту, напрямую к мониторной системе, например, к стерео усилителю мощности, или другому стерео тракту.

Выходы «Mon Out» L и R воспроизводят аудио, которое в Pro Tools маршрутизируется на аналоговые выходы 1 и 2 соответственно. Эти аналоговые выходы имеют 24-битные ЦАП.

Aux In (Линейный и Phono входы)

Секция Aux In предоставляет две пары входов для разных типов оборудования. Входы Aux In Line L и R - 1/4" (6.35мм) балансные разъемы TRS. Входы Phono – небалансные коаксиальные разъемы RCA.
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Клемма заземления
Клемма предназначена для заземления вертушек и других типов DJ оборудования, подключаемого к Mbox 2 Pro.

Входы Mic/Line 1 и 2

Каждый аналоговый канал ввода (Input 1 и Input 2) имеет микрофонный (XLR) и линейный (TRS) входы на универсальном разъеме. На передней панели уровень входного сигнала регулируется ручкой Gain соответствующего канала, а тип входа (Mic/Line или DI) задается при помощи переключателей «Source». Переключатель канала 2 находится с левого края (если смотреть со стороны задней панели), а переключатель канала 1 правее. Входы соответствующие переключателям Source 1 и Source 2 расположены на задней панели так, чтобы быть точно на одной линии со своими переключателями. Это позволяет вам быстрее найти входные гнезда, когда вы смотрите со стороны передней панели.

[Стр. 35]
Раздел 7. Подключение к оборудованию

Чтобы услышать аудио, записанное в сессии Pro Tools, вам необходимо подключить наушники или внешнюю систему звукоусиления (например, активные мониторы или домашняя стерео система) к Mbox 2 Pro. Звук от Mbox 2 Pro не может воспроизводиться через встроенную карту или динамики вашего компьютера.

Подключение наушников

На передней панели Mbox 2 Pro находится два 1/4" (6.35мм) гнезда для подключения наушников, каждое со своей регулировкой громкости, обозначенные как А и В. Вы можете использовать два комплекта наушников при сведении или записи.
Регулировка громкости наушников (А, В)

1/4" (6.35мм) выходы на наушники (А, В)
3-4 (Выход В)

Выход на наушники и органы управления на передней панели Mbox 2 Pro
Наушники A осуществляют мониторинг основного микса Pro Tools (обычно выходные каналы 1-2).
По умолчанию наушники В дублируют выходные каналы 1-2 Pro Tools, которые подаются на наушники А. Если требуется подать отдельный микс при записи наложений, выход наушников В может быть переключен на мониторинг выходных каналов 3-4.
Не используйте расположенные на передней панели выходы на наушники для подключения чего-либо, кроме наушников. Если вы используете усилитель-распределитель для наушников или систему субмикса, задействуйте любой из шести доступных линейных выходных каналов на задней панели. См. «Дополнительные аналоговые выходы», стр. 36.

Чтобы подключить наушники для мониторинга микса:

· Подключите наушники с 1/4" (6.35мм) стерео джеком (или адаптером) к выходу для наушников А.

Чтобы подключить наушники для переключаемого мониторинга:

· Подключите наушники с 1/4" (6.35мм) стерео джеком (или адаптером) к выходу для наушников В.

Чтобы осуществлять мониторинг каналов 3-4 через наушники В:

· Нажмите переключатель «3-4», так, чтобы он был в нажатом положении.

Информацию о маршрутизации сигнала, посылах и шинах для субмиксов см. «Pro Tools Reference Guide» 
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Подключение звуковой системы

Мониторные выходы «Mon Out», расположенные на задней панели Mbox 2 Pro совместимы с 1/4" (6.35мм) джеками. Возможно подключение 1/4" (6.35мм) балансных или небалансных TRS (Tip-Ring-Sleeve) и небалансных TS (Tip-Sleeve) джеков. Чтобы слышать свою сессию Pro Tools, вы можете подключить эти выходы к любой системе звукоусиления: активным мониторам, домашней стерео системе или микшерному пульту.

При подключении к стерео системе подключайте левый канал (обычно белый разъем) к выходу «Mon Out L», а правый канал (обычно красный) к «Mon Out R».

Выходы «Mon Out» L и R play воспроизводят аудио, которое в Pro Tools маршрутизируется на аналоговые выходы 1 и 2. 

Выходы на мониторы

Мониторные выходы на задней панели Mbox 2 Pro

В домашних стерео системах часто используются разъемы use RCA. Для их совместимости с 1/4" (6.35мм) (Tip-Ring-Sleeve) джеками можно использовать адаптеры или специальные кабели.

Дополнительные аналоговые выходы
В дополнение к основным выходам на мониторы Mbox 2 Pro имеет так же шесть аналоговых выходных каналов. Они включают в себя выходы Line Out 1–4 и Line Out 5–6

Additional outputs on Mbox 2 Pro (back panel)

Line Out 1–4

Линейные выходы 1–4 могут быть подключены к любому прибору с аналоговыми входами. Используйте эти четыре 1/4" (6.35мм) TRS выхода для подачи сигнала на такие аналоговые устройства как усилители для наушников или системы субмикса для отдельных миксов в нашуниках, сэмплеры или внешние рекордеры.

Line Out 5–6

Выход Line Out 5–6 дает дополнительно пару аналоговых выходных каналов. Используйте этот небалансный 1/4" (6.35мм) стерео разъем для организации двух аналоговых выходов. (Line Out 5 = Tip, Line Out 6 = Ring).

Чтобы подключиться к дополнительным выходам Mbox 2 Pro:

1 При помощи кабелей с 1/4" (6.35мм) TRS джеками подключайте любые выходы Line Out (1–4) на задней панели к входам ваших внешних устройств.

2 При помощи 1/4" (6.35мм) TRS стерео кабеля подключайте выход Line Out (5–6) на задней панели ко входам вашего внешнего устройства.

Информацию о маршрутизации сигнала, посылах и шинах для субмиксов см. «Pro Tools Reference Guide»
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Подключение цифровой деки

Если у вас CD-рекордер, DAT дека или другой прибор, поддерживающий S/PDIF, подключите его к разъемам RCA «S/PDIF In» и «S/PDIF Out» на задней панели Mbox 2 Pro
При записи из Pro Tools на цифровое устройство, убедитесь, что в Pro Tools параметр Clock Source установлен корректно. Подробно см. «Цифровой вход и выход», стр. 42.

Подключение аудио входов 

Здесь описываются аналоговые входы, предоставляемые Mbox 2 Pro. Детали касательно специфики подключения различных типов источника сигналов содержатся в параграфах “Подключение микрофона к Mbox 2 Pro”, стр. 38 и “Подключение инструментов к Mbox 2 Pro”, стр. 40.

Обзор аналоговых входов

Mbox 2 Pro предоставляет четыре канала аналогового ввода. На Mbox 2 Pro они обозначены как Input 1, Input 2 и Aux In L-R.
Input 2 Input 1 Aux In
Входы на задней панели Mbox 2 Pro
Input 1 и Input 2

Секции Input 1 и 2 содержат входы Mic/Line In 1 и 2 соответственно на задней панели, а также входы DI (TS) на передней панели. Эти входы отображаются в Pro Tools как Analog In (1–2) 

Mic/Line In

Каждая секция Mic/Line In (Input 1 или 2) на задней панели имеет универсальные входы, которые поддерживают разъемы XLR или TRS.
XLR Для микрофонных кабелей с разъемами XLR
TRS Для кабелей с 1/4" (6.35мм) Tip-Ring-Sleeve (TRS) джеками от клавишных, микшеров и других источников линейного сигнала.
Если вы используете микрофон с 1/4" (6.35мм) разъемом, подключайтесь к входам DI на передней панели
DI 1 and DI 2

Каналы Input 1 и 2 также имеют входы DI на передней панели. 
DI Для кабелей с 1/4" (6.35мм) Tip-Sleeve джеками при подключении гитар, бас-гитар, микрофонов и аналогичных источников.

Input 1 and 2 front panel DI connectors.

Aux In

Разъемы Aux In предназначены для линейных и Phono источников. В Pro Tools эти входы отображаются как Analog In (3–4):

Line L и R Для кабелей с 1/4" (6.35мм) Tip-Sleeve джеками при подключении гитар, бас-гитар, микрофонов и аналогичных источников.
Phono L и R Для кабелей с разъемами RCA при подключении вертушек, микшеров и другого DJ оборудования.

[Стр. 38]
Подключение микрофона к Mbox 2 Pro
Микрофонные кабели и разъемы

Есть несколько способов использования Mbox 2 Pro с микрофоном, которые зависят от применяемого типа микрофона и кабеля. 

Некоторые микрофонные кабели используют для подключения к входу разъемы XLR (как на Mbox 2 Pro); другие микрофоны используют 1/4" (6.35мм) джеки. Если у вас есть возможность выбора, используйте разъемы XLR для подключения микрофона к Mbox 2 Pro, чтобы получить результат лучше.

Разъем XLR

1/4" джек
Разъемы XLR и1/4” 

Фантомное питание

Некоторым микрофонам для работы требуется электропитание. Это, так называемое, фантомное питание, обеспечивается либо устанавливаемой в микрофон батареей, либо со стороны аудио интерфейса (например, Mbox 2 Pro), который подает питание по микрофонному кабелю.

Большинству конденсаторных микрофонов (например, AKG C3000) для работы требуется фантомное питание. Динамическим микрофонам (таким, как Shure SM57) для работы не требуется фантомное питание, но оно не может им повредить. 

Хотя фантомное питание безопасно для большинство микрофонов, оно может представлять определенный риск для некоторых ленточных микрофонов. Прежде чем подключить или отключить ленточный микрофон обязательно отключайте фантомное питание и выдержвайте паузу не менее десяти секунд.

Mbox 2 Pro может подавать фантомное питание только по микрофонным кабелям с разъемами XLR

Если вы не уверены насчет необходимости фантомного питания для своего микрофона, обратитесь к его документации или к службе поддержки производителя.
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Использование микрофона с разъемом XLR

Чтобы использовать микрофон с разъемом XLR:

1 Подключите микрофонный кабель к одному из входов Mic/Line на тыльной панели Mbox 2 Pro.

Input 1

Вход Mic/Line
Разъем XLR, подключенный к секции Input 1

2 Установите тип входного сигнала «Mic» (микрофонный), нажав кнопку переключателя входа «Mic/DI» на передней панели Mbox 2 Pro. Должен гореть индикатор «Mic»

Переключатель Mic/DI

DI Mic

Индикаторы
Переключатель входа секции Input 1 и индикаторы

4 Если ваш микрофон требует фантомного питания, убедитесь, что он подключен, после чего включите фантомное питание при помощи кнопки «48V» на передней панели Mbox 2 Pro. Эта кнопка подает фантомное питание на оба микрофонных входа. Когда 48В фантомное питание включено, горит индикатор «48V».

Выключатель фантомного питания

Выключатель фантомного питания

4 На передней панели Mbox 2 Pro поверните ручку Monitor до желаемого уровня
Регулировка Monitor Ручка чувствительности
Регулировка Monitor и ручка чувствительности входной секции Input 1

5 На передней панели Mbox 2 Pro осторожно поверните ручку чувствительности «Input 1» вправо, чтобы увеличить входной уровень микрофонного сигнала.

6 Если входной сигнал слишком сильный, нажмите кнопку Pad, чтобы включить -20дБ аттенюатор.

Аттенюатор секции Input 1

[Стр. 40]
Использование микрофона с 1/4" (6.35мм) разъемом

Чтобы использовать микрофон с 1/4" (6.35мм) TS (Tip-Sleeve) разъемом:

1 Подключите микрофонный кабель к одному из 1/4" (6.35мм) входов «DI» на передней панели Mbox 2 Pro.

Input 1 Подключение микрофона к разъему «DI» секции «Input 1»

2 Установите тип входного сигнала «DI», нажав кнопку переключателя входа «Mic/DI». Должен гореть индикатор «DI»

Переключатель Mic/DI

Переключатель входа секции «Input 1» и индикатор «DI»

3 На передней панели Mbox 2 Pro осторожно поверните ручку чувствительности соответствующей входной секции вправо, чтобы увеличить входной уровень микрофонного сигнала.

4 Если входящий сигнал слишком громкий, нажмите на задней панели кнопку «Pad», чтобы включить -20дБ аттенюатор.

Подключение инструментов к Mbox 2 Pro
Mbox 2 Pro имеет входы двух типов «Line» и «DI», которые соответствуют разным уровням сигнала от разных типов инструментов и оборудования.

DI (Передняя панель) Такие инструменты, как электрогитара или бас-гитара обычно имеют имеют меньший уровень выходного сигнала, чем инструменты с линейным сигналом, и им нужен вход типа DI (“Direct Inject”).

Line (Задняя панель) Приборы с выходным сигналом линейного уровня, в частности, такие электронные источники аудио как мишкеры, сэмплеры, клавишные, вертушки и синтезаторы требуют входа «Line» на задней панели.

Aux In (Задняя панель)

Входы Line L и R предназначены для подключения дополнительных устройств с линейным выходом, а входы Phono L и R – для вертушек/предусилителей, DJ микшеров и аналогичных устройств. 1/4" (6.35мм) входы Line L и R поддерживают балансные и небалансные подключения. Входы RCA полностью совместимы с RIAA, кроме того в Mbox 2 Pro имеется клемма заземления, необходимая для таких подключений. Вы можете подключать устройства к обеим парам входов Aux In и переключаться между ними при помощи кнопки Source на передней панели.
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Подключение электрогитары или бас-гитары

Чтобы подключить гитару к Mbox 2 Pro:

1 Подключите гитарный кабель к одному извходов «/DI» Mbox 2 Pro.

Input 1 DI

Подключение гитары к разъему «DI» секции «Input 1»

2 Установите тип входного сигнала «DI», нажав кнопку переключателя входа «Mic/DI». Должен гореть индикатор «DI»

3 На передней панели Mbox 2 Pro поверните ручку Monitor до желаемого уровня
4 На передней панели Mbox 2 Pro осторожно поверните ручку чувствительности соответствующей входной секции вправо, чтобы увеличить входной уровень гитарного сигнала

Подключение клавишных и микшеров

Чтобы подключить клавишные или микшер к Mbox 2 Pro:

1 Подключайте клавишные, микшер или другой источник аудио к TRS входам «Line» секций «Input 1» или «Input 2». Если вы работаете со стерео сигналом (стерео выход клавишных или микшера), подключайте левый канал (часто маркируется белым) к секции «Input 1», а правый канал (часто маркируется красным) к секции «Input 2».

Если ваш клавишный инструмент имеет небалансные выходы, используйте use the входы «DI» на Mbox. Справьтесь с документацией на ваш инструмент.

2 Установите тип входного сигнала «Mic», нажав кнопку переключателя входа «Mic/DI» на передней панели. Должен гореть индикатор «Mic»
3 На передней панели Mbox 2 Pro поверните ручку Monitor до желаемого уровня

4 Установите оптимальный выходной уровень у своего источника сигнала. Например, для большинства клавишных оптимальный уровень составляет 80%-100% от максимальной громкости.

5 На передней панели Mbox 2 Pro осторожно поверните ручку чувствительности соответствующей входной секции вправо, чтобы увеличить входной уровень сигнала от вашего инструмента.
Чтобы использовать линейные входы Aux In (3–4):

1 Подключите клавишные, микшер или другой источник линейного сигнала к входам Aux In Line (L и R).

2 На передней панели Mbox 2 Pro нажмите кнопку Source секции Aux In так, чтобы индикатор Phono не светился. Переключатель будет в «отжатом»положении.

Подключение DJ оборудования

Чтобы использовать входы Phono:

1 Подключите вертушку, микшер или сходные по выходу устройства к входам Aux In Phono (L и R).

2 Если требуется, подключите заземление вертушки к соответствующей клеммен на Mbox 2 Pro. Это необходимо в случае некоторых преампов и другого DJ оборудования, чтобы предотвратить появление ненужного шума и фона.

3 На передней панели Mbox 2 Pro нажмите переключатель Source секции Aux In так, чтобы индикатор Phono светился. Кнопка должна быть в «нажатом» положении.

[Стр. 42]
Цифровой вход и выход

Mbox 2 Pro предоставляет два канала цифрового ввода/вывода S/PDIF на задней панели. Это позволяет записывать сигналы с цифровых устройств в Pro Tools и посылать цифровое аудио из Pro Tools на другие цифровые устройства.

S/PDIF

In
Out

Разъемы S/PDIF на Mbox 2 Pro

Подключение цифровых устройств

Чтобы подключить устройство S/PDIF к Mbox 2 Pro:

1 Используйте два 75Ом кабеля с разъемами RCA «папа» на каждом конце (приобретается отдельно).

2 Подключите выход S/PDIF устройства к входу S/PDIF на Mbox 2 Pro, а вход S/PDIF устройства к выходу S/PDIF на Mbox 2 Pro.

3. Прочитайте следующую важную информацию.
Работа с входом S/PDIF

Этот параграф описывает шаги, которые вы должны предпринять после установки и запуска Pro Tools LE , чтобы активировать порты S/PDIF для цифрового ввода. Сверяйтсесь с этим параграфом всякий раз, когда собираетесь использовать вход S/PDIF на Mbox 2 Pro

Следующие требования относятся только использованию входа S/PDIF для записи или мониторинга цифровых сигналов через Pro Tools LE и Mbox 2 Pro

Чтобы активировать входы S/PDIF на Mbox 2 Pro:
1 Убедитесь, что вы подключили внешнее цифровое устройство к правильному разъему S/PDIF на Mbox 2 Pro (In и Out).

2 Убедитесь, что внешнее устройство включено, имеет корректную частоту дискретизации и настроено на подачу синхронизацию S/PDIF (если таковая заложена в устройство)

3. Запустите Pro Tools LE
1 Войдите в меню Setups > Hardware Setup.

2 Выберите «S/PDIF» в качестве параметра Clock Source.

На передней панели эта настройка включит индикатор «S/PDIF»

3 Нажмите «OK».

4 На записываемом треке выберите соответствующий моно или источник S/PDIF.

Активация входа S/PDIF в диалоге Hardware Setup
После активации в диалоге Hardware Setup входы S/PDIF придут в рабочее состояние и будут подавать аудио на Mbox 2 Pro.
[Стр. 43]

Установка параметра Clock Source to S/PDIF – единственный способ использовать вход S/PDIF. После чего вы можете осуществлять запись и мониторинг до шесть независимых входных каналов (четыре аналоговых входных канала и два входных канала S/PDIF).
Выбор другого значения Clock Source (Internal или Word Clock) отключает вход S/PDIF. Выходы S/PDIF остаются доступными.
Подключение MIDI

Два порта MIDI на Mbox 2 Pro дают возможность воспользоваться всеми функциями MIDI в Pro Tools LE, включая запись и редактирование треков MIDI.

Если вам нужны дополнительные порты MIDI, вы можете добавить совместимый интерфейс MIDI. USB интерфейсы MIDI эффективно работают с Pro Tools на Windows и Mac. MIDI интерфейсы с последовательным подключением поддерживаются только в версии для Windows.

Только USB интерфейсы MIDI поддерживаются системами Pro Tools для Mac OS X. Адаптеры модем-последовательный порт и интерфейсы MIDI с  последовательным подключением не поддерживаются.

Чтобы подключить свое устройство MIDI к Mbox 2 Pro:

1 Подключите станартный 5-pin кабель MIDI к порту MIDI Out своего устройства и порту MIDI In на тыльной панели Mbox 2 Pro.

2 Подключите другой кабель MIDI к порту MIDI In своего устройства и порту MIDI Out на тыльной панели Mbox 2 Pro.

MIDI

In Out
MIDI подключения в Mbox 2 Pro 
MIDI – не аудио. Чтобы слышать выход ваших устройств MIDI через Pro Tools, вы должны маршрутизировать аудио выход своего устройства MIDI в аудиовходы  Mbox 2 Pro и проводить мониторинг или запись в вашей сессии, как описано в “Подключение аудио входов», стр. 37. Пример работы с MIDI и включения его в сессии см Раздел 8 «Основные задачи в Pro Tools LE»ю
См. также Приложение А «Настройка MIDI Studio Setup (только Windows)» или Приложение В «Настройка AMS (только Mac OS X) с информацией о настройке MIDI студий для работы с Pro Tools.
Word Clock
Mbox 2 Pro имеет на задней панели разъемы Word Clock In и Out, которые дают возможность синхронизировать Pro Tools LE и Mbox 2 Pro по стандарту Word clock. Word clock используется для синхронизации широкого спектра устройств, таких как нелинейные видеосистемы, и другие виды оборудования, обычно используемого в задачах профессионального аудио.

Имя как вход, так и выход Word clock ваша система Pro Tools на основе Mbox 2 Pro может работать в режимах Word clock “slave” или “master.”
Не путайте Word clock и другие формы временной синхронизации с тайм-кодом и другими формами позиционной синхронизации. Обзор терминологии и концепций синхронизации см. «Pro Tools Reference Guide»
Чтобы подключить источник Word clock к Mbox 2 Pro:

При помощи высококачественных 75Ом коаксиальных кабелей с разъемами BNC (не входят в комплект), соедините разъемы Word Clock In и Out на Mbox 2 Pro к портам синхронизации на других устройствах, поддерживающих Word clock
Использование Word Clock в Pro Tools LE
Система Pro Tools LE на основе Mbox 2 Pro может работать режиме источника Word clock master или в режиме slave, синхронизируясь по сигналу Word clock от внешнего источника.

Pro Tools LE в режиме Word Clock Master

Выход Word clock всегда активен, позволяя Pro Tools подавать сигнал Word clock на любое подключенное устройство, поддерживающее стандарт Word clock.
Чтобы использовать Pro Tools LE как источник Word clock master:

1 Убедитесь в корректности всех подключений между Mbox 2 Pro и вашими внешними устройствами.

2 Переведите все внешние устройства в режим slave по Word clock, исходящему от Mbox 2 Pro. (Не забудьте проверить настройки частоты дискретизации, необходимое терминирование, и другие внутренние настройки устройств. Если вам нужна дополнительная информация о конкретных требованиях, обратитесь к документации производителя на ваше оборудование).
3 Запустите Pro Tools.

4 Войдите в меню Hardware > Setup.

5 Откройте меню Clock Source и выберите Internal.

Pro Tools LE в режиме Word Clock Slave
Чтобы синхронизировать Pro Tools в режиме slave по внешнему источнику Word clock, вы должны установить в Pro Tools в качестве источника синхронизации Word clock.
Чтобы настроить Pro Tools LE и Mbox 2 Pro в режим Word clock slave:

1 Убедитесь в корректности всех подключений аудио и Word clock.

2 Убедитесь, что внешний источник Word clock включен и настроен на выдачу 1x Word clock. (Проверьте необходимое терминирование в соответствии с документацией производителя на ваше оборудование)
3 Запустите Pro Tools.

4 Войдите в меню Hardware > Setup.

5 Откройте меню Clock Source и выберите Word clock.
Когда в качестве источника синхронизации в Pro Tools задано Word clock или Interna, цифровой вход не работает. Чтобы использовать вход S/PDIF, в качестве источника синхронизации в Pro Tools должно быть задано S/PDIF. Подробнее см. «Цифровой Вход и Выход» стр. 42) 

Использование ножного переключателя
Разъем ножного переключателя на Mbox 2 Pro позволят вам использовать педаль ножного переключателя для управления стартом/остановкой воспроизведения или начала/остановки записи «врезкой». Поддерживаются режимы врезки аудио QuickPunch и врезка MIDI.
Гнездо ножного переключателя на Mbox 2 Pro позволяет вам использовать ножной переключатель для старта/остановки воспроизведения или старта/остановки записи «врезкой»l.

Поддерживается как функция QuickPunch записи «врезкой» аудио, так и «врезка» MIDI. 
Разъем ножного переключателя разработан для использования с педалями разового срабатывания с ¼" (6.35мм) разъемами TS connector. Педали постоянного замыкания/размыкания также могут быть использованы, но результат может быть непредсказуемым.

Чтобы использовать ножной переключатель:

1 Подключите переключатель к соответствующему разъему на задней панели Mbox 2 Pro.

2 Запустите Pro Tools.

3 Войдите в меню Setup > Hardware.

4 Выберите Record Punch In/Out или Playback

Start/Stop.

5 Нажмите Ok.
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Раздел 8. Основные задачи в Pro Tools LE

Этот раздел призван дать новым пользователям представление о конкретных методах работы при выполнении основных задач в системе Pro Tools.

Самая подробная информация по работе с Pro Tools содержится в «Pro Tools Reference Guide».

Вы можете просмотреть электронную версию документа в формате PDF через меню Help в Pro Tools
В этом разделе в качестве примера рассматриваются аналоговые входы. Чтобы вести запись в цифровом формате через вход S/PDIF на Mbox, последовательность шагов практически такая же с одной важной оговоркой: в Pro Tools надо установить «S/PDIF» в качестве значения параметра «Clock Source» в диалоге Hardware Setup. Подробнее см. «Цифровой вход и выход», стр. 43

Запись сессии Pro Tools

Прежде чем начать запись с использованием Pro Tools и Mbox 2 Pro, вы должны сперва создать сессию Pro Tools, а затем подготовить к записи аудио трек.

Чтобы создать сессию Pro Tools:

1 Проверьте подключения между Mbox 2 Pro и вашим инструментом или микрофоном.

Информацию о подключении см. в Разделе 6. «Подключение к оборудованию».”

2 Запустите Pro Tools.

3 Зайдите в меню File > New Session.

4 В диалоге New Session при необходимости задайте параметры сессии или оставьте их по умолчанию. (Подробно о настройках New Session см «Pro Tools Reference Guide».)

Диалог New Session
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5 Выберите место сохранения своей сессии.

6 Задайте имя своей сессии
7 Нажмите «Save».

Чтобы подготовить к записи аудио трек:

1 Выберите меню Track > New.

2 Выберите «1 Mono Audio Track in Samples», если у вас моно источник сигнала, или «1 Stereo Audio Track in Samples», если у вас стерео сигнал.

Создание нового стерео аудио трека

3 Нажмите «Create».

Моно инструмент использует один вход Mbox 2 Pro, а стерео инструмент использует два. Создание стерео трека в Pro Tools не превратит моно инструмент в стерео инструмент. Если моно инструмент записать в стерео трек, один канал стерео трека не будет содержать сигнала.

4 Откройте новое окно Mix через меню Window > Mix.

5 В окне Mix откройте для нового трека селектор входного тракта.

6 В выпадающем меню выберите вход интерфейса, с которого вы будете осуществлять запись. Например, выберите «Analog 1», если сигнал подан на входную секцию «Input 1» Mbox 2 Pro.

Маршурутизация входа на моно трек

7 Подайте сигнал инструмента или источника сигнала с громкостью, на которой будете вести запись.

8 Используйте настройку входной чувствительности на Mbox 2 Pro, чтобы обеспечить максимальный входной уровень сигнала в Pro Tools, избегая при этом перегрузки.

Перегрузка возникает, когда вы подаете сигнал, уровень которого выше, чем способен принять входной контур. Чтобы избавиться от перегрузки отрегулируйте сперва выходной уровень на источнике сигнала, затем на Mbox 2 Pro. Установите эти два уровня так, чтобы индикаторы пиков на передней панели не светились красным. (На передней панели есть по одному индикатору пиков на каждый вход. Индикаторы светятся зеленым, когда входной сигнал имеет уровень примерно –60 dBFS, ярко желтым при  –6 dBFS, и красным, когда сигнал достигает  –0 dBFS ).
Чтобы записать аудио трек:

1 Нажмите кнопку назначения трека на запись 

Назначение трека на запись в окне Mix

[Стр. 49]
2 Выберите в меню Track > Input Only Monitoring. Это позволяет вам осуществлять мониторинг треков, которые назначены на запись.

3 Войдите в меню Window > Transport, чтобы отобразилось окно транспорта. Нажмите кнопку сброса в ноль, чтобы перейти в начало сессии

Врезка

Сброс в ноль

Перемотка назад

Стоп

Воспроизведение

Перемотка вперед

Переход в конец трека

Запись

Окно транспорта

4 Нажмите кнопку «Запись» в окне транспорта, чтобы подготовить Pro Tools к записи. Кнопка «Запись» начинает мигать красным, показывая, что Pro Tools все готово к записи.

5 Когда вы готовы приступить к записи, нажмите кнопку «Воспроизведение» или клавишу пробела.

6 Записывайте свою партию.

7 По окончании записи нажмите кнопку «Стоп» в окне транспорта или клавишу пробела.

Чтобы воспроизвести записанный трек:

1 Если трек подсвечена кнопка назначения трека на запись, нажмите ее, чтобы вывести трек из режима записи.

2 Чтобы начать воспроизведение, нажмите кнопку «Воспроизведение» в окне транспорта или клавишу пробела.

3 Чтобы остановить воспроизведение, нажмите кнопку «Стоп» в окне транспорта или клавишу пробела.

.

Импортирование аудио с CD

Чтобы импортировать аудио с компакт-диска:

1 Вставьте CD с аудио материалом в привод CD/DVD 
2 Откройте браузер Workspace через меню Window > Workspace. Браузер Workspace – это окно через которое вы можете осуществлять поиск, предварительное прослушивание и организацию своих аудио файлов.

Открытие браузера Workspace

3 В браузере Workspace щелкните на иконке «Audio CD», чтобы увидеть файлы на CD.

4 Для предварительного прослушивания аудио файла, щелкните на иконке динамика в колонке Waveform. Чтобы остановить воспроизведение, нажмите клавишу пробела.

Предварительное прослушивание аудиофайла в браузере Workspace
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5 Чтобы импортировать файл в новый трек, перетащите его из браузера Workspace в список Track List окна редактирования Edit.

Перенос аудио файла из браузера Workspace в список Track List окна Edit.
Чтобы воспроизвести новый трек: 

1 В окне Transport нажмите кнопку сброса в ноль, чтобы перейти в начало трека

2 Чтобы начать воспроизведение, нажмите кнопку «Воспроизведение» в окне транспорта или клавишу пробела.

3 Чтобы остановить воспроизведение, нажмите кнопку «Стоп» в окне транспорта или клавишу пробела.

.
Создание аудио CD из сессии Pro Tools

Pro Tools не создает аудио CD непосредственно, но вы можете создавать из своих сессий Pro Tools стерео аудио файлы, которые могут быть использованы большинством программ прожига CD

Сброс аудио на диск

Используйте функцию Pro Tools «Bounce to Disk», чтобы собрать все слышимые треки в один «мастер» аудио файл. После того, как новый аудио файл сброшен на диск, вы можете нарезать его на CD.

Если вы сбрасываете аудио с 24-битным разрешением в 16-битный формат (разрешение CD), вам следует использовать на главном выходе плагин дитеринга. (Подробности см. в «Pro Tools Reference Guide».)

Чтобы сбросить аудио на диск:

1 После того, как вы закончили запись и сведение сессии в Pro Tools задайте на линейке отсчета времени (или на треке) продолжительность сессии, добавив также некоторое количество времени, чтобы избежать обрывания хвостов реверберации, которые могут продолжать звучать после последнего региона.

Аудио материал сессии выбран и готов к сбросу 

2 Выберите меню File > Bounce to > Disk.

Выбор Bounce to Disk в меню File

3 В диалоге Bounce Options выберите Outputs 1–2 в качестве значения параметра Bounce Source.

4 Выберите BWF (.WAV) в качестве значения File Type.
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5 Выберите Stereo Interleaved в качестве значения Format.

6 Выберите 16 в Resolution и 44100 в Sample Rate.

7 Если вы меняете частоту дискретизации в файле сброса, задайте параметр Conversion Quality.

(Подробности см. в «Pro Tools Reference Guide».)

 Выберите “Convert after Bounce” и нажмите «Bounce». 

Опции Bounce для создания треков пригодных к нарезке на CD

9 В диалоге Bounce задайте имена сбрасываемым трекам и выберите место, в котором они должны быть сохранены.

Ввод имени сбрасываемого файла

10 Нажмите «Save».

Pro Tools начинает сброс на диск. Сброс в Pro Tools осуществляется в реальном времени, поэтому вы можете слышать воспроизведение своего микса в процессе сброса (но не можете что-то изменить)

Диалог Bouncing to Disk

Прожиг CD

После того, как сброс завершен, у вас будет аудио файл, готовый к нарезке на CD. Выйдите из Quit Pro Tools и запустите любое из распространенных приложений для прожига CD, чтобы нарезать на CD сброс своего микса.

Убедитесь, что ваше приложение прожига CD настроено так, чтобы создать аудио CD, а не CD с данными.
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Запись MIDI в сессии Pro Tools

Что такое MIDI?

Информация MIDI (Musical Instrument Digital Interface) – это не аудио и не содержит собственно звуков. MIDI – это коммуникационный протокол для музыкальных устройств. MIDI – это данные, которые могут управлять устройством, поддерживающим MIDI (например, клавишным инструментом или программным синтезатором).

Чтобы создать или воспроизвести запись MIDI, вам требуется MIDI контроллер или звуковой модуль (аппаратный или виртуальный), подключенные к компьютеру через порты MIDI или MIDI-интерфейс. Аудио от вашего инструмента MIDI может быть прослушано через мониторинг Mbox 2 Pro или послано на внешний микшер.

MIDI клавиатура (контроллер)

MIDI 

Звуковой модуль MIDI
Аудио

Микшер

К усилителю

Сигнальный тракт инструментов MIDI

Запись MIDI в формате Instrument Track

В Pro Tools треки типа Instrument Track обеспечивают как MIDI так и аудио функциональность, поэтому вы можете записывать MIDI, и осуществлять аудио мониториг через программные или аппаратные инструменты.

Чтобы записывать или воспроизводить треки с данными MIDI, ваша система Pro Tools должна быть настроена для работы с MIDI. См. Приложение А «Настройка MIDI Studio Setup (только для Windows” или Приложение В  “Настройка AMS (только для Mac OS X)”.

Чтобы создать дорожку Instrument Track и настроить ее на запись:

1 Войдите в меню Setup > MIDI > Input Devices, убедитесь, что ваше входное устройство выбрано в окне MIDI Input Enable и нажмите «OK».

2 Войдите в меню Track > New, задайте тип «1 Mono Instrument Track», затем нажмите «Create».

Создание нового трека формата Mono Instrument

3 Выберите пункт меню View > Mix Window > Instruments, чтобы отобразились параметры MIDI для дорожки типа Instrument

Режим Instrument View в окне Mix 

4 В окне Mix сверху дорожки типа Instrument откройте селектор входа MIDI и назначьте на запись устройство и канал или поставьте «All».

Селектор входа MIDI 

Селектор входа MIDI у трека типа  Instrument
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5 В зависимости от типа инструмента, который вы используете сделайте одно из следующего:

• Если вы используете плагин виртуального иструмента, откройте селектор Insert и назначьте плагин на трек типа Instrument. MIDI выход трека автоматически будет назначен на инструментальный плагин.

Назначение инструментального плагина в треке типа Instrument

• Если вы используйте внешнее устройство MIDI, откройте селектор MIDI Output трека (сверху трека типа Instrument) и назначьте устройство и канал, которые должны получать выход MIDI (выбор зависит от устройства).

Селектор выхода MIDI в треке типа Instrument

Если подключенное устройство MIDI не видно, проверьте конфигурацию компьютера и его настройки MIDI. Подробнее см. Приложение А «Настройка MIDI Studio Setup (только для Windows)» и приложение Б Настройка AMS (Только Mac OS X)

6 Если вы используете внешнее устройство MIDI и подключили его аудио выход к Mbox 2 Pro для мониторинга в Pro Tools, откройте селектор Input трека типа Instrument и выберите соответствующий аудио вход. (этот шаг не является обязательным, если вы используете инструментальный плагин)

Выбор аудио выхода для трека типа Instrument

7 В окне Mix нажмите кнопку назначения трека на запись, что бы подготовить ваш трек типа Instrument к записи MIDI..

Track Record Enable button

Назначение трека типа Instrument для записи MIDI 

8 Убедитесь, что выбрана опция Options > MIDI Thru.
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9 Сыграйте несколько нот на своем контроллере MIDI и посмотрите на реакцию индикатора MIDI Velocity трека. Помните, MIDI – не аудио, и индикатор MIDI Velocity не фиксирует громкость аудио, а активность MIDI.

Индикатор MIDI Velocity

Индикатор MIDI трека типа Instrument показывает активность MIDI. 

10 Отрегулируйте громкость аудио выхода трека типа Instrument его фейдером громкости.

Фейдер громкости

Регулировка фейдера громкости трека типа Instrument

Чтобы записать MIDI в треке типа Instrument:

1 Убедитесь, что трек типа Instrument, который вы хотите записать, назначен на запись и принимает MID..

2 В окне Transport нажмите кнопку сброса в ноль, чтобы перейти в начало трека.

Вы также можете записывать в выбранный участок трека или с точки установленного в окне Edit курсора.

3 Нажмите кнопку «Запись» в окне транспорта.

Врезка

Сброс в ноль

Перемотка назад

Стоп

Воспроизведение

Перемотка вперед

Переход в конец трека

Запись

Окно транспорта

4 Чтобы начать запись нажмите кнопку воспроизведения в окне транспорта или нажмите клавишу пробела.

5 Играйте на MIDI контроллере или с другого входного устройства.

6 По окончании записи нажмите кнопку «Стоп» в окне транспорта или клавишу пробела.

Только что записанная информация MIDI появится как регион MIDI на треке в окне Edit, а также в списке регионов.

Данные MIDI в треке типа Instrument

Чтобы воспроизвести записанные данные MIDI:

1 Нажмите кнопку назначения трека на запись, чтобы вывести его из режима записи.

2 В окне Transport нажмите кнопку сброса в ноль, чтобы перейти в начало трека.

3 Чтобы начать воспроизведение, нажмите кнопку «Воспроизведение» в окне транспорта. Записанные данные MIDI будут воспроизводиться через назначенный на трек инструмент и канал.
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Приложение A: Настройка MIDI Studio Setup (только для Windows)
Настройка MIDI Studio Setup

Настройка MIDI Studio Setup (MSS) позволяет вам настроить контроллеры MIDI и звуковые модули, которые подключены к вашей системе, и управлять маршрутизацией данных MIDI между вашим оборудованием MIDI и Pro Tools.

MSS автоматически находит интерфейсы MIDI и дает возможность задать оригинальное имя каждому из портов MIDI в документе MIDI Studio Setup.

MSS также поддерживает файлы имен патчей на основе XML для хранения и импортирования имен патчей ваших внешних устройств MIDI.

Конфигурации MIDI Studio Setup, созданные в MSS могут быть целиком импортированы и экспортированы.

Окно MIDI Studio Setup

Окно MIDI Studio Setup разделено на три секции. Настройки интерфейса находятся сверху окна. Все заданные на данный момент инструменты отображены в спискe Name в левой части окна. Детальное отображение параметров MIDI находится в секции Properties справа.

Окно MIDI Studio Setup

Настройки интерфейса

Create Эта кнопка добавляет новый инструмент в список Name.

Delete Эта кнопка удаляет выбранный инструмент или инструменты из списка Name.

Import Эта кнопка позволяет вам импортировать готовый файл MIDI Studio Setup
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Export Эта кнопка позволяет вам экспортировать текущий файл MIDI Studio Setup.

Show Duplicate Emulated Ports Когда выбрана эта опция, и вы используете MIDI интерфейс , который поддерживает time stamp (например, MIDI I/O), окно MIDI Studio отображает как выходные порты с time-stamp DirectMusic, так и эмулируемые дубликаты без time-stamp.

Некоторые интерфейсы MIDI не могут корректно загрузить или выгрузить свои драйверы, если вы не закроете и не перезапустите Pro Tools. Подробную информацию ищите в документации своего интерфейса MIDI. 

Список инструментов Name

Список инструмента содержит все заданные на текущий момент инструменты. Выбрав инструмент в списке, вы увидите его параметры в секции Properties.

Секция Properties

Секция Properties позволяет вам редактировать информацию о новых инструментах, или инструментах выбранных в списке Name. Когда вы выбираете очередной инструмент в списке, секция Properties изменяется в соответствии с его параметрами.

Секция Properties окна MIDI Studio Setup 

Чтобы задать инструмент через MIDI Studio Setup:

1 Выберите меню Setup > MIDI > MIDI Studio.

2 Нажмите «Create».

3 В поле Instrument Name введите имя своего инструмента и нажмите «Ввод».

Если вы не ввели имя инструмента, поле Instrument Name будет автоматически заполнено информацией из полей Manufacturer и Model.

4 Задайте производителя и модель нового устройства в соответствующих выпадающих меню. Если меню Manufacturer и Model не предлагают выбор, соответствующий конкретно вашему устройству, выбирайте «None».

5 В выпадающем меню Input выберите входной порт на вашем интерфейсе MIDI, который подключен к выходу MIDI Out вашего инструмента.

6 В выпадающем меню Output выберите выходной порт на вашем интерфейсе MIDI, который подключен к входу MIDI In вашего инструмента.

7 Активируйте соответствующие каналы MIDI (1–16) в опциях Send Channels и Receive Channels (Это определяет какие каналы работают на передачу и прием MIDI.)

Instrument Name

Поле Instrument Name отображает задаваемое пользователем имя для выбранного инструмента.

[Стр. 57]

Manufacturer

Выпадающее меню Manufacturer предлагает список производителей оборудования MIDI . Список загружается из XML файлов устройств MIDI.

Подробнее см “Поддержка имен патчей MIDI”, стр. 57.

Model

Выпадающее меню Model предлагает список устройств MIDI, отобранных по имени производителя. Этот список загружается из XML файлов устройств MIDI, предоставляемых при установке Pro Tools.

Подробнее см “Поддержка имен патчей MIDI”, стр. 49.

Input Port

Выпадающее меню Input Port отображает список доступных входных портов интерфейса MIDI. Входы будут включать в себя все интерфейсы MIDI, активные в вашей системе. Установленный и отображаемый порт интерфейса MIDI – это тот порт, через который данные посылаются от внешнего устройства MIDI, заданного в поле Name, на ваш интерфейс MIDI.
Если входной порт задан как «None», данный инструмент не появится как вариант в селекторе входов MIDI.

Output Port

Выпадающее меню Output Port отображает список доступных выходных портов интерфейса MIDI. Установленный и отображаемый порт интерфейса MIDI – это тот порт, через который данные посылаются на внешнее устройство MIDI, заданное в поле Name, от вашего интерфейса MIDI.

Если выходной порт задан как «None», данный инструмент не появится как вариант в селекторе выходов MIDI.

Send Channels

Сетка Send Channels задает каналы передачи для устройства MIDI, заданного в поле Name.

Receive Channels

Сетка Receive Channels задает каналы приема для устройства MIDI, заданного в поле Name.

Поддержка имен патчей MIDI

Pro Tools поддерживает формат XML (Extensible Markup Language) для хранения и импортирования имен патчей ваших внешних устройств MIDI. Pro Tools устанавливает файлы имен патчей MIDI (.midnam) для фабричных патчей по умолчанию у большинства распространенных устройств MIDI. Эти файлы хранятся в каталогах, отсортированных по имени производителя в папке Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign.

Чтобы импортировать имена патчей MIDI в Pro Tools:

1 Проверьте имя устройства MIDI в окне MIDI Studio Setup (см. “Настройка MIDI Studio Setup”, стр. 47).

2 Убедитесь, что выход трека MIDI корректно назначен на устройство MIDI.
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3 Нажмите кнопку выбора патча у трека MIDI.
Кнопка выбора патча
Кнопка выбора патча, окно Edit

Кнопка выбора патча
Кнопка выбора патча, окно Mix

4 В диалоге выбора патча нажмите кнопку «Change»
Кнопка «Change»

Диалог выбора патча

5 В диалоге Open откройте папку Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign\<имя производителя> и выберите файл с именами патчей MIDI (.midnam) для устройства MIDI.
6 Нажмите «Open».

Диалог выбора патча будет наполнен именами патчей, и выпадающее меню Patch Name Bank появится в левом верхнем углу окна.

После того, как имена патчей импортированы в Pro Tools, они становятся доступными для данного устройства MIDI во всех сессиях. 
Диалог выбора патча с именами патча

Чтобы очистить список имен:
В диалоге выбора патча нажмите кнопку «Clear», после чего нажмите Done.

Файлы с именами патчей MIDI (.midnam) могут быть отредактированы в любом текстовом редакторе, также можно использовать сторонние разработки для редактирования и упорядоченного хранения имен патчей, чтобы создавать собственные имена патчей.

[Стр. 59]
Приложение B. Настройка AMS (Только Mac OS X)

Audio MIDI Setup

Pro Tools опознает порты на вашем интерфейсе MIDI как стандартные (generic) парты. В Mac OS X используется утилита Apple Audio MIDI Setup (AMS) для идентификации внешних устройств MIDI, подключенных к вашему интерфейсу MIDI, и настройки вашей MIDI студии для работы с Pro Tools.
Чтобы настроить свою MIDI студию через AMS:

1 Сделайте следующее:

• Запустите Audio MIDI Setup (находится в Applications/Utilities).

– или –

• В Pro Tools, выберите меню Setup > MIDI > MIDI

Studio.

2 Выберите «MIDI Devices». AMS просканирует вашу систему на подключенные интерфейсы MIDI. Если ваш MIDI интерфейс правильно подключен, он появится в окне со всеми пронумерованными портами.

3 Для каждого устройства MIDI, подключенного к MIDI интерфейсу выберите «Add Device». Появится иконка нового внешнего устройства с изображением по умолчанию в виде MIDI клавиатуры.

4 Перетащите иконку нового устройства в удобное место внутри окна.
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5 Соедините устройство MIDI с MIDI интерфейсом щелкните на стрелке соответствующего выходного порта устройства и протянув связь или «кабель»к входной стрелке соответствующего входного порта MIDI интерфейса.

Организация входных и выходных соединений MIDI (на примере Digidesign Command|8)

6 Щелкните на стрелке соответствующего входного порта устройства и протяните связь или «кабель»к выходной стрелке соответствующего выходного порта MIDI интерфейса.

Чтобы удалить соединение, выберите «кабель» и нажмите «Delete». Чтобы удалить все соединения, нажмите «Clear Cables».

7 Повторите шаги 3–6 для каждого устройства MIDI в вашей конфигурации MIDI.
Чтобы задать конфигурацию внешнего устройства миди:

1 Выберите иконку внешнего устройства, после чего выберите команду Show Info (или сделайте двойной щелчок на иконке нового устройства).

Иконка внешнего устройства

2 В соответствующих выпадающих меню выберите производителя и модель нового устройства.

(Если меню Manufacturer и Model не предлагают выбор, соответствующий конкретно вашему устройству вы можете набрать имя вручную).
Именование нового устройства MIDI

За названиями производителя и модели  AMS обращается к одному или более файлу с расширением “.middev” в каталоге Root/Library/Audio/MIDI Devices. Pro Tools устанавливает файл, содержащий информацию о многих доступных в продаже устройствах MIDI, под названием “Digidesign Device List.middev”. Если имена производителя или модели для какого-либо из ваших внешнихустройств MIDI не содержатся в выпадающих меню AMS Manufacturer и Model, вы можете добавить их, отредактировав файл.middev в любом текстовом редакторе (например, TextEdit).

[Стр. 61]
3 Выберите стрелку More Properties, чтобы расширить диалог, после чего  активируйте соответствующие каналы MIDI (1–16) в опциях Transmits и Receives Channels (Это определяет какие каналы будет использовать устройство для передачи и приема MIDI.)
Активация каналов MIDI 
4 Щелкните на изображении устройства. Откроется окно, отображающее изображения для различных устройств MIDI (таких как клавишные, модули, интерфейсы и микшеры). Выберите иконку для своего устройства.

Выбор иконки устройства

Чтобы использовать свои собственные иконки, вы можете разместить графические файлы TIFF в папке /Library/Audio/MIDI Devices/Generic/Images,и они появятся как варианты в окне устройств AMS

5 Нажмите «OK».

Имена устройств, которые вы вводите, появляются в Pro Tools в качества вариантов входа и выхода MIDI.
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Поддержка имен патчей MIDI

Pro Tools поддерживает формат XML (Extensible Markup Language) для хранения и импортирования имен патчей ваших внешних устройств MIDI. Pro Tools устанавливает файлы имен патчей MIDI (.midnam) для фабричных патчей по умолчанию у большинства распространенных устройств MIDI. Эти файлы хранятся в каталогах, отсортированных по имени производителя в папке /Library/Audio/MIDI Patch Names/Digidesign.

Чтобы импортировать имена патчей MIDI в Pro Tools:

1 Проверьте имя устройства MIDI в окне Audio

MIDI Setup (см. “Настройка Audio MIDI Setup” стр. 51).

2 Убедитесь, что выход трека MIDI корректно назначен на устройство MIDI.

3 Нажмите кнопку выбора патча у трека MIDI

Кнопка выбора патча
Кнопка выбора патча, окно Edit

Кнопка выбора патча
Кнопка выбора патча, окно Mix

4 В диалоге выбора патча нажмите кнопку «Change»

Кнопка «Change»

Диалог выбора патча

5  В диалоге Open откройте папку /Library/Audio/MIDI Patch Names/Digidesign/<имя производителя > и выберите файл с именами патчей MIDI (.midnam) для устройства MIDI.

6 Нажмите «Open».

Диалог выбора патча будет наполнен именами патчей, и выпадающее меню Patch Name Bank появится в левом верхнем углу окна.

После того, как имена патчей импортированы в Pro Tools, они становятся доступными для данного устройства MIDI во всех сессиях. 

Чтобы очистить список имен:

В диалоге выбора патча нажмите кнопку «Clear», после чего нажмите Done.

Файлы с именами патчей MIDI (.midnam) могут быть отредактированы в любом текстовом редакторе, также можно использовать сторонние разработки для редактирования и упорядоченного хранения имен патчей, чтобы создавать собственные имена патчей.
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Приложение С: Конфигурация и эксплуатация жесткого диска
Рекомендуется начинать работу с аудио на только что отформатированном вторичном или внешнем диске. Вам также следует периодически проводить дефрагментацию диска с аудио, чтобы не страдала производительность системы.

Всегда создавайте резервную копию важных данных с вашего диска перед форматированием, поскольку оно сотрет всю информацию с диска
Избегайте записи на системный диск
Не рекомендуется вести запись на системный диск. Запись и воспроизведение с сисемного диска могут привести с уменьшению максимального количества треков или плагинов.

Поддерживаемые форматы и типы дисков
Форматы дисков
Windows Системы Windows XP должны использовать диски только формата NTFS 

Системы Windows могут также поддерживать диски Mac формата HFS+ (часто называется Mac OS Extended). Подробности см. «Pro Tools Reference Guide»

Mac Системы Mac должны использовать диски, отформатированные под файловые системы HFS или HFS+.

Диски HFS поддерживаются только как диски для переноса информации.

Производительность жесткого диска зависит от ряда факторов, включая конфигурацию системы, количество треков, частоту дискретизации сессии, плотность редактирования, количества кроссфейдов и других процессов в сессии, таких как Beat Detective.

Полный список требований к жестким дискам приведен на сайте Digidesign (www.digidesign.com).

Жесткие диски SCSI 

Digidesign рекомендует использовать сертифицированные жесткие диски SCSI с сертифицированным контроллером шины SCSI HBA или (на системах Windows) сертифицированным встроенным контроллером SCSI HBA на материнской плате.

Полная информация о количестве треков и поддерживаемом количестве и конфигурации дисков SCSI содержится на сайте Digidesign (www.digidesign.com).

Жесткие диски FireWire

Digidesign рекомендует использовать сертифицированные жесткие диски FireWire (на системах Windows) сертифицированные контроллеры FireWire.
Полная информация о количестве треков и поддерживаемом количестве и конфигурации дисков FireWire содержится на сайте Digidesign (www.digidesign.com).
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Жесткие диски IDE/ATA/SATA

Сертифицированный встроенный диск IDE/ATA/SATA может быть использован как выделенный диск для аудио.

Полная информация о количестве треков на встроенных дисках содержится на сайте Digidesign (www.digidesign.com).

Форматирование диска для аудио
Форматирование дисков в Windows

(Только для Windows)

Для оптимальной производительности диски для аудио должны быть отформатированы в FAT32 или NTFS.

Чтобы отформатировать диск:

1 В Windows Vista нажмите «Пуск».

2 Правым щелчком откройте Компьютер (Windows Vista) или Мой Компьютер (Windows XP) и выберите «Управление»

3 В разделе «Запоминающие устройства» выберите «Управление дисками».

Окно управления дисками (Windows XP
4 Если том “здоровый” выполните следующее:

«Здоровый» том, это том на котором созданы и отформатированы разделы.

• В окне управления дисками правой кнопкой откройте меню жесткого диска, который вы будете использовать для аудио, и выберите «Форматирование».

• В окне форматирования задайте имя тома.

• Выберите файловую систему. Для оптимальной производительности диски для аудио должны быть отформатированы в NTFS. 

• Выберите “Произвести быстрое форматирование.”

• Убедитесь, что опция «Сжатие файлов и папок» отключена
• Установите размер кластера «По умолчанию».

• Нажмите «OK».

Pro Tools поддерживает только базовые диски. Не конвертируйте тип диска в динамический
5 Если раздел кластера в томе на задан, выполните следующее:

• В окне управления дисками правой кнопкой откройте меню жесткого диска, который вы будете использовать для аудио, и выберите «Новый раздел».
• В окне мастера нового раздела нажмите «Далее».

• При запросе выберите тип раздела.

Digidesign рекомендует использовать основные разделы, а не дополнительные.

• Следуйте отображаемым на экране инструкциям, выбирая размер раздела и другие параметры раздела.

• При запросе выберите файловую систему. Для оптимальной производительности диски для аудио должны быть отформатированы в NTFS. 
• Выберите “Произвести быстрое форматирование.”

• Убедитесь, что опция «Сжатие файлов и папок» отключена

• Установите размер кластера «По умолчанию».

• Нажмите «OK».
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Форматирование дисков для аудио на Mac

(Только для Mac)

Для оптимальной производительности диски для аудио должны быть форматированы как Mac OS Extended (Journaled).

Чтобы форматировать диск:

1 Запустите приложение Disk Utility, находящееся в Applications/Utilities.

Disk Utility (Mac OS X)

2 Откройте закладку Erase.

3 Выберите диск, который вы хотите инициализировать, в колонке с левой стороны окна.

4 Выберите формат Mac OS Extended (Journaled).

Не выбирайте опцию форматирования “Case-Sensitive”. Pro Tools не будет корректно работать с дисками, форматированными с чувствительностью к регистру
5 Введите имя нового тома
6 Если вы планируете подключать диск к компьютеру с Mac OS 9, выберите опцию «Install Mac OS 9 Drivers».

7 Нажмите «Erase».

Диск с новым именем тома появится на рабочем столе.
Разделы диска
Разделы создают логические тома на физическом диске, как если бы вы создавали виртуальные жесткие диски. Разделы могут быть форматированы под соответствующую файловую систему (NTFS или FAT32 в Windows, HFS+ в Mac).

Разделы дисков FAT32 drive имеют предел в 2 терабайта (2000 гигабайт), в то время как размеры разделов в NTFS практически не имеют предела.

Windows XP позволяет видеть диск, форматированный с файловой системой NTFS или FAT32, как целый том. Отдельно взятый аудио файл Pro Tools не может быть размером более 2048 М.

Mac OS позволяет видеть диск больший, чем 4096 МБ как целый том. Диски должны быть инициализированы утилитой, которая опознает 2ТБ предел. Отдельно взятый аудио файл Pro Tools не может быть размером более 2048 М.

Время поиска на дисках с разделами.

Время поиска реально быстрее на дисках с разделами (в предположении, что чтение и запись происходит на одном разделе), поскольку головкам приходится осуществлять поиск в пределах одного раздела, а не по всей емкости диска.

Меньший размер раздела более «быстрый», чем больший, но это происходит за счет цельности пространства хранения данных. Когда вы разделяете диск, вам требуется найти компромисс, который лучшим образом отвечает вашим требованиям к емкости и скорости доступа.

Избегайте размещения аудио файлов одной и той же сессии по разным разделам одного и того же диска, поскольку это существенно ударит по производительности.
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Дефрагментация дисков для аудио
Системы Mac 

Работая с большими файлами (такими как видео) вы можете ограничить фрагментацию, сохраняя копии важных файлов на другой диск, стирая затем оригинал файла, и копирования файла обратно, вместо того, чтобы проводить дефрагментацию.
Системы Windows
Периодически дефрагментируйте диски с аудио, чтобы не падала производительность системы. Для максимальной эффективности записи и воспроизведения, данные должны записываться на ваш жесткий диск непрерывно – минимизируя тем самым затраты на поиск необходимых фрагментов. К сожалению, ваш компьютер не всегда может хранить звуковые файлы подобным образом, и вынужден записывать на диск там, где найдется свободное место.

При многодорожечной записи, аудио треки записываются в виде раздельных файлов, равномерно распределенных по диску. Хотя фрагментация отдельных файлов может быть нулевой, треки могут быть размещены достаточно далеко друг от друга, и чтение будет сопряжено с интенсивным поиском. Кроме того, оставшееся на диске свободное место будет дискретным, что увеличивает вероятность фрагментации последующих проходов записи.

Увеличение фрагментации увеличивает вероятность сбоев диска, что может накладываться на воспроизведение аудио и приводить к ошибкам работы.

В системах Windows, чтобы избегать фрагментации, форматируйте диски с большим размером кластеров (например 32K).

Оптимизация (дефрагментация) дисков
Чтобы предотвратить фрагментацию, вы можете оптимизировать свой диск, перераспределив файлы в непрерывном формате. Большинство программ оптимизации дают вам возможность протестировать диск, оценив процент фрагментации. Если у диска наблюдается средняя или сильная фрагментация, вам стоит оптимизировать его.

Если вы используете вашу систему для интенсивного редактирования, часто стираете аудио или файлы со своего диска, вам может понадобиться еженедельная или даже более частая 

оптимизация диска, потому что даже большой жесткий диск довольно быстро фрагментируется.
Резервное копирование данных перед оптимизацией
Поскольку в процессе оптимизации ваши файлы будут переписываться, всегда делайте перед оптимизацией диска резервную копию данных. Вы так же должны использовать сервисные утилиты, чтобы найти и исправить все проблемы до оптимизации или переформатирования дисков. Если каталоги вашего диска как-либо повреждены до оптимизации, результатом может быть серьезная потеря данных.
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Дефрагментация дисков для аудио в Windows

Чтобы дефрагментировать диск в Windows Vista:
1 Войдите в меню Windows > Панель управления.

2 Откройте «Система и ее обслуживание»

3 Откройте «Счетчики и средства производительности»

4 Откройте «Дополнительные инструменты»

5 Откройте дефрагментацию диска

6 В окне дефрагментации диска нажмите «Дефрагментировать сейчас»

Команда «Дефрагментировать сейчас» дефрагментирует все ваши жесткие диски. Это может отнять много времени, особенно в системах с несколькими дисками.

Опытные пользователи могут использовать утилиту командной строки Defrag.exe, чтобы дефрагментировать диски по отдельности. Дополнительную информацию см. в документации Windows Vista.

Чтобы дефрагментировать диск в Windows XP:

1 Правым щелчком на Мой Компьютер откройте меню и выберите «Управление»

2 В разделе «Запоминающие устройства» выберите «Дефрагментация диска»

3 В окне дефрагментации дисков, выберите диск, который хотите дефрагментировать

4 Нажмите кнопку «Дефрагментация» и следуйте инструкциям на экране.

По завершению дефрагментации закройте окно «Управление компьютером».

Использование дисков Mac в системах Windows

Версия Pro Tools для Windows позволяет вам осуществлять запись и воспроизведение непосредственно с диском формата Mac (HFS+), подключенным к системе Windows.

Эта функциональность требует, чтобы сессия, сделанная на Mac, включая аудио файлы, целиком лежала на диске Mac.
Во время установки Pro Tools не забудьте выбрать опцию «Mac HFS+ Disk Support». Эта опция позволяет вашей системе Pro Tools осуществлять дисковые операции, воспроизведение и запись с дисками формата Mac HFS+

Информация об использовании опции «Mac HFS+ Disk Support» содержится в руководстве «HFS+ Disk Support Option Guide».

Информация об обмене сессиями между системами Mac и Windows содержится в руководстве «Pro Tools Reference Guide».

Форматирование и эксплуатация дисков HFS+


Чтобы форматировать и разделить диск в формате HFS+, подключите диск к компьютеру Mac и используйте Apple OS X Disk Utility.
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Использование емкости жесткого диска
Моно аудио треки записанные с качеством 16 бит, 44.1 кГц (качество CD) требуют примерно 5МБ дискового пространства на минуту материала. Такие же треки записанные с разрешением 24 бит требуют около 7.5МБ на минуту
Стерео аудио треки записанные с качеством 16 бит, 44.1 кГц (качество CD) требуют примерно 10МБ дискового пространства на минуту материала. Такие же треки записанные с разрешением 24 бит требуют около 15МБ на минуту

В Таблице 4 приведены требуемые для определенного количества и длительности треков объемы дискового пространства, что поможет вам планировать использование емкости своего жесткого диска.

Таблица 4. Требуемое дисковое пространство для аудио треков (сессии 44.1 кГц и 48 кГц)

	Количество треков и длительность 
	 16 бит, 44,1 кГц  
	 16 бит, 48 кГц  
	 24 бит, 44,1 кГц  
	 24 бит, 48 кГц  

	 1 моно трек, 1 мин  
	 5 МБ  
	 5,5 МБ  
	 7,5 МБ  
	 8,2 МБ  

	 1 стерео трек (или два трека), 5 мин  
	 50 МБ  
	 55 МБ  
	 75 МБ  
	 83 МБ  

	 1 стерео трек (или два моно трека), 60 мин  
	 600 МБ  
	 662 МБ  
	 900 МБ  
	 991 МБ  

	 24 моно трека, 5 мин  
	 600 МБ  
	 662 МБ  
	 900 МБ  
	 991 МБ  

	 24 моно трека, 60 мин  
	 7 ГБ  
	 7,8 ГБ  
	 10,5 ГБ  
	 11,6 ГБ  

	 32 моно трека, 5 мин  
	 800 МБ  
	 883 МБ  
	 1,2 ГБ  
	 1,3 ГБ  

	 32 моно трека, 60 мин  
	 9,4 ГБ  
	 10,4 ГБ  
	 14 ГБ  
	 15,4 ГБ  
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Приложение Д. Устранение проблем
Резервное копирование материала
Настоятельно рекомендуется проводить резервное копирование вашего материала на регулярной основе, особенно перед внесением изменений в конфигурацию системы.

Резервное копирование данных сессии
Почаще проводите резервное копирование своих сессий и аудио. Есть широкий выбор носителей, которые пригодны для резервного копирования проектов различного объема, включая дополнительные жесткие диски, пишущие CD/DVD приводы, автоматические ленточные архиваторы и оптические диски высокой емкости.

Оптимальный способ копирования сессии целиком – использование командыe Save Copy In. Эта команда позволяет вам сохранить файл сессии и все связанные с ним файлы в новом месте.

Вы также можете использовать функцию Auto Save Backup, (в настройке Operation Preferences), чтобы в Pro Tools происходило автоматическое копирование файла сессии в процессе работы
Резервное копирование конфигурации вашей системы
После настройки своей системы и Pro Tools вам следует сохранить образ своей системы при помощи утилиты резервного копирования Norton Ghost (Windows) или Bombich Carbon Copy Cloner (Mac). Таким образом вы сможете быстро восстановить конфигурацию и настройки системы, в случае возникновения каких-то проблем.By doing this, you can quickly restore.
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Распространенные проблемы
Pro Tools не запускается
Проблема
Когда вы делаете двойной щелчок на приложении Pro Tools или файле сессии Pro Tools, Pro Tools не запускается или выдает сообщение об ошибке.

Возможные решения
· Убедитесь, что ваш компьютер имеет требуемое для работы Pro Tools количество оперативной. См. сайт Digidesign (www.digidesign.com).

· Попробуйте полный перезапуск. Выключите аудио интерфейсы, компьютерную периферию и ваш компьютер. Затем включите все это снова в правильной последовательности.

· Если вы пытались запустить Pro Tools двойным щелчком на файле сессии Pro Tools, попробуйте следующее:
• Закройте все сообщения об ошибках.
• Двойным щелчком запустите приложение Pro Tools.
• В Pro Tools, через меню File > Open Session откройте сессию.
· Переустановите Pro Tools с установочного диска Pro Tools.

Аудио интерфейс не распознается
Проблема
Когда вы запускаете Pro Tools, программа не распознает аудио интерфейс или подключенный аудио интерфейс не включается.

Возможные решения
· Выключите компьютер и проверьте, что ваши кабели надежно и правильно соединяют компьютер и аудио интерфейс. 

· Проверьте правильность настроек диалога Hardware Setup.

· Попробуйте отсоединить кабель USB от порта USB на Mbox 2 Pro и снова подключить его. Если индикатор USB по-прежнему не горит, выключите компьютер, отсоедините Mbox 2 Pro и перезапустите компьютер. После полной перезагрузки компьютера снова подключите Mbox 2 Pro.

Вопросы производительности
Есть некоторые факторы, которые могут существенно снизить производительность Pro Tools. Они включают в себя:

Сетевые подключения. Закройте все сетевые подключения, если только вы не используете их для обмена аудио данными по сети.

Фоновые приложения. Любые программные утилиты, выполняемые в фоновом режиме или обращающиеся к диску, такие как защита от вирусов, оптимизация диска, защита файлов, должны быть удалены или отключены.

Заставки Экрана Заставки экрана должны быть полностью отключены перед запуском Pro Tools.

Энергосбережение Некоторые функции автоматического энергосбережения, например те, что замедляют вращение системного жесткого диска могут повлиять на производительность Pro Tools. Эти опции должны быть отключены.
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Перед тем как обратиться в службу поддержки Digidesign

Зарегистрируйте свою систему
Зарегистрируйте свою систему немедленно по прочтении регистрационной карты Digidesign, прилагаемой ко всем системам Pro Tools. Регистрация покупки – единственный способ получить право на техническое сопровождение и предложения по обновлению системы. Регистрация – один из важнейших шагов, которые должен выполнить новый пользователь.

Используйте ресурсы Digidesign

Помимо печатных и электронных версий руководств Pro Tools ваша система включает следующие источники информации:
Файлы Read Me Содержат самую свежую информацию и известные проблемы касательно программных и аппаратных конфигураций Pro Tools.
Файлы Read Me размещаются в папке Documentation во время установки Pro Tools.
База знаний Это база данных, посвященная распространенным проблемам, ошибкам ядра DAE и решениям по их устранениям, основанных на новейшей информации от службы технической поддержки Digidesign. Эта база данных размещается я в папке Digidesign во время установки Pro Tools. База знаний также доступна на сайте Digidesign (www.digidesign.com).

Сайт (www.digidesign.com) Это ваш лучший ресурс Интернет, помогающий получить максимум от вашей системы Pro Tools..

Сбор важной информации
Digidesign стремится помочь вам решить проблемы настолько быстро и эффективно, насколько возможно. Если в момент обращения в службу технической поддержки у вас на руках будет следующая информация, это поможет ей быстрее диагностировать вашу проблему. Потратьте насколько минут на сбор следующей базовой информации:

Информация о системе
Компьютер
• Производитель, модель, частота процессора
• Количество оперативной памяти
• Операционная система (версия Windows или Mac OS)

• Любые драйверы, дисковые утилиты и другие системные приложения, которые могут быть установлены
Оборудование Digidesign

• Тип карт, интрефейсов и периферийных устройств
Жесткие диски
• Производитель, модель
• Объем диска (ГБ)

• Скорость вращения (об/мин)

• Тип диска (SCSI, FireWire, IDE/ATA)

• Утилита, использованная для форматирования диска
• Количество и размер разделов на диске
ПО Digidesign

• Версия Pro Tools

• Версии плагинов
• Другое ПО Digidesign

• Дополнительные плагины от партнеров Digidesign по разработке
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Другое оборудование
Обратитесь к документации производителей за параметрами устройств.

Самые распространенные аппаратные расширения включают:

• Карты 1394 (FireWire) для систем Windows (производитель, модель)

• Карты захвата видео (производитель, модель)
Чтобы проверить сертификацию своего оборудования на совместимость с системами Pro Tools, обратитесь с свежей информации о совместимости на сайте Digidesign (www.digidesign.com).

Другое ПО
Если вы используете другие аудио или видео приложения, обратитесь к документации разработчика за деталями.

Отметьте работу другого ПО в момент возникновения проблемы.

Диагностическая информация
Отметьте любые ошибки ядра DAE и коды других ошибок, сообщения о которых вы получили.

Кроме того, проверьте возможность воспроизвести проблему в различных условиях, например, с другой сессией или после изменения настроек (таких как Hardware Buffer Size).
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